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Preface
Overview

Welcome to Installing Rational RequisitePro. This document provides the information 
you need to install RequisitePro, configure enterprise databases for RequisitePro 
projects, and configure your Web server for RequisiteWeb. 

Rational RequisitePro, the premier requirements management tool, integrates a 
powerful multi-user requirements database utility with the familiar environment of 
Microsoft Word for Windows, enabling you to simultaneously work with a 
requirements database and requirements documents. 

The Rational Software Setup program lets you perform standard and custom 
installations of RequisitePro. The common install procedure allows you to install 
enterprise database configuration scripts, RequisiteWeb components, and related 
documentation. 

This manual provides you with:

� Information needed to perform a typical installation of RequisitePro and 
RequisiteWeb. 

� Information needed to remove RequisitePro and RequisiteWeb from your system. 

� Instructions for configuring Oracle and Microsoft SQL Server databases for 
RequisitePro projects.

� Instructions for installing RequisiteWeb server components on IIS and Apache 
Web servers.

� Notes on configuring the Rational E-mail Reader for use with RequisitePro 
projects.

Audience

This guide is intended for anyone who is installing RequisitePro and its related 
components. It assumes a basic knowledge of Microsoft Windows and its 
conventions. Enterprise database configuration requires the support of a database 
xi



administrator. To install and configure RequisiteWeb, you should be familiar with the 
selected platform and Web server.

Other Resources

� The release notes appear at the end of the RequisitePro installation. They are 
available from a link in the Let’s Go RequisitePro application, which appears 
when you first launch RequisitePro. They are also available on the Start menu in 
the Rational RequisitePro program group. You must have a Web browser to view 
the release notes. 

� The Administering Licenses for Rational Software manual, included with your 
installation materials, describes the Web-based license manager AccountLink, the 
Rational License Key Administrator, and the Rational software licensing model. 
This manual also provides instructions and troubleshooting information for 
acquiring, installing, and configuring licenses. You must install license keys to use 
Rational products; you can install them before or after you install the products. 

� The guide Using Rational RequisitePro and other Rational product 
documentation is included on a separate CD: Rational Solutions for Windows – 
Online Documentation CD. Rational online manuals are presented in PDF format. To 
read PDF files, you must install Adobe Acrobat Reader, available from the Adobe 
Web site, http://www.adobe.com/, or on the Rational Solutions for Windows CD in 
the extras directory.

� Online Help. You can view online help within RequisitePro whenever 
you need assistance. To display the Help Contents, click the Help 
button on the Tool Palette; on the Help menu, click Contents and 
Index; or press the F1 key. You can also click the Help button in any 
dialog box.

� For information on integrating RequisitePro with Rational Rose and Rational 
ClearQuest, refer to the manuals Getting Started with Rational Suite 
AnalystStudio and Configuring Rational Suite on the Rational Solutions for 
Windows – Online Documentation CD. 

� For more detail on the Rational Software Setup program, including information on 
implementing a silent installation, refer to the manual Installing Rational Suite on 
the Rational Solutions for Windows – Online Documentation CD. 

� Rational Training Services. For more information on training opportunities, see 
the Rational University Web site: http://www.rational.com/university.
xii Preface
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Contacting Rational Technical Publications

To send feedback about documentation for Rational products, please send e-mail to 
our technical publications department at techpubs@rational.com.

Contacting Rational Technical Support

If you have questions about installing, using, or maintaining this product, contact 
Rational Technical Support as follows:

Please help our Technical Support staff deliver quality customer service by providing 
complete information. The techsupport.html file, which is located in the RequisitePro 
installation directory and is also available by clicking Help > Contacting Technical 
Support, contains a Customer Information Form. You can use this form to document 
problems, questions, or suggestions and to detail your company and system 
information. The form can be copied into your e-mail message.

Attach your error.log file (located in the RequisitePro installation directory in the bin 
folder) if you are getting an error message. Add any files, screen captures, and other 
information you feel are relevant.

Table 1 Rational Technical Support Information

Location Contact Information Notes

U.S. and Canada 800-433-5444

781-676-2450

support@rational.com

When sending e-mail:
� Specify the product name in the 

subject line, for example, 
“RequisitePro”. 

� For existing issues, include your case 
ID in the subject line.

Europe +31 (0) 20 4546 200

support@europe.rational.com

Asia Pacific +61-2-9419-0111

support@apac.rational.com

World Wide Web http://www.rational.com Click the Technical Support link. 
xiv Preface
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Licensing Support

Table 2 provides Rational License Support contact information. If you have questions 
about acquiring license keys for your Rational Software products, contact Rational 
License Support. See the online help in the Rational License Key Administrator for 
additional licensing support information.

Other Contacts

Joining the RequisitePro Users Mailing List 

Rational has created an open e-mail list “req_forum@rational.com” for customers to 
exchange ideas on using RequisitePro. This list is monitored to ensure that product 
questions and problems are being answered. To subscribe to the mailing list, go to the 
following Web site: http://www.rational.com/products/reqpro/usergroups.

Table 2 Rational Licensing Support

 Region Telephone E-mail

North and South 
America 

1-800-728-1212

1-781-676-2510

FAX: 781-676-2510

lic_americas@rational.com

Europe
(includes Israel 
and Africa)

Phone: +31 20 4546 200

Fax: +31 20 4546 202

lic_europe@rational.com

Asia Pacific Phone: +61-2-9419-0111
FAX: +61-2-9419-0123

lic_japan@rational.com
(Japanese)

lic_apac@rational.com
(English only)
Other Contacts xv
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1Before You Install
This chapter presents system requirements and general guidelines to help you 
prepare for installing or upgrading Rational RequisitePro. This chapter includes the 
following topics:

� System and Software Requirements on page 2

� Administrator Privileges on page 3

� Installing Multiple Rational Products on page 3

� General Requirements on page 4

� Software Use on page 5

� Installation Types on page 5

� Installing Shared Files on page 6

� Upgrading from an Earlier Version of Rational RequisitePro on page 7

� Silent Installations on page 7
1



System and Software Requirements

Table 3 describes the system and software requirements for installing the RequisitePro 
client. 

*Recommendations for Microsoft Office:
� with Windows 95 and Windows NT, use Office 97;
� with Windows 98, Windows ME, and Windows 2000, use Office 2000.

Table 3 RequisitePro Client Requirements

Item Requirement

Operating Systems One of the following:
� Microsoft Windows 2000 Professional Service Pack 1
� Microsoft Windows 98 Second Edition
� Microsoft Windows NT 4.0 Workstation Service Pack 6a
� Microsoft Windows 95 OEM Service Release 2
� Microsoft Windows Millennium Edition

Processor 200 MHz or greater; 300 MHz or higher is recommended

Memory 64 MB or greater; 128 MB is recommended. For UCM, 256 MB is 
recommended for RequisitePro project administrators.

Disk Space 100 MB

Monitor 800 X 600 X 256-color video resolution, or greater; 
High Color or True Color recommended

Mouse/pointing 
device 

Microsoft Mouse or compatible pointing device

Word Processor Microsoft Word 97 Service Release 2 or Word 2000 Service Release 1*

Requirement Metrics 
Reporting

Microsoft Excel 97 Service Release 2 or Excel 2000 Service Release 1*

Browser Microsoft Internet Explorer 4.0 Service Pack 1 or later* 
(Required for RequisitePro operation. For RequisiteWeb requirements, 
see RequisiteWeb System Requirements on page 38.)

LAN Support Microsoft networks

Automated License 
Key Requests

Internet connection required for automated license requests

Oracle Client Versions 7.3.4, 8.0.5, 8.1.5, 8.1.6
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Table 4 describes the system and software requirements for installing an enterprise 
database for RequisitePro. 

Administrator Privileges

To use the Rational Software Setup program on a Windows NT or 2000 system, you 
must have Windows NT or 2000 administrator privileges on the local system. Log in 
as one of the following users:

� local administrator
� member of the local administrator group
� domain administrator who is a member of the local administrator group

Installing Multiple Rational Products 

If you install individual Rational products and a Rational Suite edition on the same 
system, the system user will first obtain a Suite license by default. To change the order 
in which users obtain licenses on that system, see the Administering Licenses for 
Rational Software manual.

Table 4 RequisitePro Enterprise Database Requirements

Item Requirement

Microsoft SQL Server 7.0 or 2000

Oracle Server Versions 7.3.4, 8.1.5, 8.1.6

Note: If you are using a version 7.3.4 server, we recommend that you 
use a version 7.3.4 client.

Memory 128 MB minimum; for projects with approximately 50,000 
requirements, 256 MB is recommended.

Note: Memory requirements vary depending on the number of 
concurrent users, the amount of data being requested, and the size of 
the database. 

Disk Space 96 MB
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General Requirements

Here is a list of general requirements for installing Rational RequisitePro and related 
components for the first time at your site.

1 Make sure that you have a current backup of your Registry and system directories. 

2 Install the Rational license keys. You can acquire and import the Rational license 
keys before or after installing Rational RequisitePro. See the Administering Licenses 
for Rational Software manual for more information about licenses, including the 
procedure for obtaining a license key.

Note:  You must install Rational licenses to use Rational products. 

3 The Rational Software Installation procedure uses C:\Program Files\Rational as the 
default install path. 

If your C:\ drive lacks sufficient free disk space, you may either specify another 
drive during the installation procedure or make space available on the default 
drive. Some files will be installed on your C:\ drive; the Software Setup wizard will 
report the amount of space required on all drives for your installation.

Note:  If you have already installed a Rational product, you cannot select an 
alternate location for another Rational product installation.

Note:  The instructions in this guide assume that you are installing Windows 
applications on your C:\ drive. If this is not the case, substitute the appropriate 
drive when performing all procedures.

4 The RequisitePro installation requires specific versions of Microsoft files whether 
you are installing RequisitePro for the first time or upgrading RequisitePro from 
an earlier version. The Rational Software Setup program will install the files, or 
you may choose to install the files from other sources. For more information, see 
Installing Shared Files on page 6.

5 To install the database configuration scripts (for Oracle or SQL Server), select the 
Custom/Full Installation Type in the Rational Software Setup procedure. 
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Software Use

The Rational Software Setup program lets you install Rational RequisitePro for use by 
a client, administrator, or evaluator. During the setup program, you select the 
installation option based on the way you will use RequisitePro on this system. See the 
table below.
.

Installation Types

The Rational Software Setup program provides you with several installation types, 
allowing you to install the configuration most appropriate for your system. The 
following table describes each type.

Table 5 Software Use Installation Choices

User Description

Client Choose this option if you do not need to administer Rational RequisitePro 
software. 

Administrator Choose this option if users of client software depend on you to set up and 
manage the team's projects and databases.

Evaluator Choose this option if you want to do a minimum amount of configuration 
work before using the product. Choosing this option does not restrict 
your use of the software. 

Table 6 Installation Types

Type Description

Typical � Installs the most commonly used features for a product. 
� Use this option for standard installations.

Custom/Full � Allows you to add or remove product features for installation. 
� Defaults to all features in a Typical installation. 
� Use this option to install Web Server Components on a Web Server for 

RequisiteWeb, or database configuration scripts for Oracle and SQL 
Server.

Compact/Laptop � Installs a subset of the standard configuration. May omit optional 
files, including online documentation or online help. 

� Use this option for installations on systems with limited disk space.
Software Use 5



Installing Shared Files

The Rational Software Setup program installs shared components that are provided 
by sources other than Rational. These software components are potentially used by 
other applications on your system. Setup installs the U.S. English version of these 
files. It does not overwrite newer file versions.

The Setup program displays a list of any shared components that require updates. 
You must install the listed files before continuing the installation.

When to Install Files Yourself

In general, we recommend that you allow the installation procedure to install shared 
files for you; however, you may want to install the files yourself under the following 
circumstances:

� You are using a U.S. English system, but installing new files may invalidate your 
current environment. In this case, you should determine how to correct your 
environment so that you can run existing tools and the Rational products you 
want to install.

� Your site may mandate that you obtain shared files directly from the source, for 
example, from Microsoft, rather than using files supplied by a third party. Or your 
site may prohibit end users from installing shared components.

� You prefer to install shared files that are localized to your language rather than the 
U.S. English versions of the files supplied by Rational. 

The check box, Replace files with newer versions in English, is enabled when 
you have installed earlier versions of the files that are localized to a non-U.S. 
English language. If you select this check box, the U.S. English versions of the files 
will replace your versions. If you clear this check box, you can save and print the 
list of files to be updated. You should update the files yourself.

Minimal � Installs the files needed to run the program from a CD or network 
location. 

� Use this option to run the program from a centrally managed location.

Note: You must have write permission to run products from a minimal 
install area.

Table 6 Installation Types

Type Description
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� There may be a later version of the files available. Rational products should work 
with the supplied version of shared files or any later versions.

Upgrading from an Earlier Version of Rational RequisitePro 

Here is a list of general requirements for upgrading Rational RequisitePro at your site.

� If you are using multiple products from the Rational Suite, all products must be 
from the same Suite version (installed from the same CD-ROM). For information 
about the order in which you should upgrade integrated products and convert 
schemas and data, see Configuring Rational Suite and the Rational Suite Release 
Notes.

� For information on removing RequisitePro from your system, see Removing 
RequisitePro on page 14.

� To upgrade RequisiteWeb, you must remove earlier versions of RequisiteWeb. See 
Removing RequisiteWeb on page 78.

Silent Installations

You can configure Rational Software Setup to perform silent installations of Rational 
software. Silent installations allow you to perform an installation of a Rational 
Software product, using the same parameters, repeatedly on a number of systems. For 
more information on silent installations, see the guide Installing Rational Suites on the 
Rational Solutions for Windows – Online Documentation CD.
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2Installing Rational 
RequisitePro 
This chapter describes how to use the Rational Software Setup wizard to install 
Rational RequisitePro, version 2001.03.10. 

For the most current information related to RequisitePro features and known issues, 
refer to the release notes, which  appear at the end of the RequisitePro installation. The 
release notes are available from a link in the Let’s Go RequisitePro application, which 
appears when you first launch RequisitePro. After the program is installed, you can 
access the release notes from the Windows Start menu in the Rational RequisitePro 
program group. 

Installing RequisitePro with Rational Software Setup 

Caution: Interrupting an installation that is in progress may leave your system in an 
indeterminate state. If you try to close the Rational Software Setup window while the 
installation is in progress, you are asked to confirm that you want to exit from the 
incomplete installation.

This section describes a typical installation of Rational RequisitePro. 

1 Insert the Rational Solutions for Windows CD into your system’s CD drive. The 
setup program starts automatically. 

If autorun is disabled on your system, click Start  >  Run. Using the drive letter of 
your CD-ROM drive, enter drive:\SETUP.EXE.

The Rational Software Setup wizard will guide you through the software 
installation. On each dialog box, click Next to proceed to the next one.

2 The Rational Software Setup dialog box provides general information about the 
software installation. Click Browse to review Rational product information. To 
view this product gallery, you must have a Web browser. 

If you do not have Rational Suite PerformanceStudio on your system, go to Step 4.
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3 If the Setup program detects Rational Suite PerformanceStudio on your system, 
you must remove PerformanceStudio before you can install a Rational Suite 
product. Rational has merged this Suite with Rational TestStudio and therefore no 
longer upgrades PerformanceStudio. You can direct the Setup program to remove 
PerformanceStudio or cancel the Setup program.

Note:  The Setup program also removes the FLEXlm Server software that was 
installed with PerformanceStudio. If you have been using the server software to 
manage your license keys, you must reinstall the FLEXlm License Server software.

4 On the Select Installation Option dialog box, choose Install Rational Product. The 
Rational Software Setup dialog box appears, which offers licensing options.

5 Select the licensing option that your system administrator has determined for 
managing RequisitePro licenses. For more information about license servers and 
Rational license key files, see the Administering Licenses for Rational Software manual 
or the Rational License Key Administrator online Help. The License Key 
Administrator appears in your Start menu when have installed Rational products 
or the FLEXlm License Server software.

6 The Choose Product to Install dialog box displays the installation options for the 
software installation. If you are not licensed for a particular product, it will not 
appear in the product list. Select Rational RequisitePro.

Table 7 License Options

Option If you select this option

Import License File You should import the Rational license file to the 
system that will run Rational products.

Obtain License Key from Server Fill in the name of the license server if the FLExlm 
license server software is already installed and 
configured on that server.

Enter Temporary Node-Locked 
Key

The Enter Temporary Key dialog box appears 
where you can enter the license key and expiration 
date found on your license key certificate. This 
dialog box also prompts you to select a Rational 
product to install.

Upgrade or Reinstall Product You do not have to install new license keys 
because you can use the product license keys that 
you already have installed.

Install Product before Licensing You can install Rational products before you install 
floating or node-locked license keys.
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7 The License Agreement dialog box displays the Rational Software license 
agreement. If you accept the license agreement, the installation continues installing 
Rational Suite on your system. If you do not accept the license agreement, the 
installation does not let you proceed further. If you exit from the installation by 
clicking the Finish button at this point, no changes are made to your system.

8 The Setup Configuration dialog box describes the setup options for this software 
installation. Select the installation option and install path. The options are Typical, 
Custom/Full, Compact/Laptop, and Minimal, described in Installation Types on page 5.

Confirm that you have sufficient free space for the installation. If the amount of 
free space is less than the amount required, either exit from the installation 
procedure and make more space available on the specified disk or specify an 
alternate Install Path. To specify another installation path, type the new path in the 
Install Path field or use the Browse button to select a drive and directory.

The installation program requires that all Rational programs be installed in the 
same directory. If any Rational product has been previously installed with the 
Rational Software Setup program, the browse option and Install Path field are 
disabled. You must remove and reinstall Rational Suite to specify a new Install 
Path.

Note:  The setup procedure installs Microsoft Core Components and some 
additional files on your C:\ drive, even if you have specified an alternate drive for 
installation. These files can require up to 20 MB of disk space on your C:\ drive.

If you are an administrator who is responsible for setting up an Oracle or SQL 
Server database for RequisitePro, select the Custom/Full installation option. If you 
choose either of the other options, go to step 10. When you choose the Custom/Full 
installation option, the Choose Features dialog box appears, which lets you specify 
exactly which features and subfeatures to install on your system. Use the + to 
expand and select or deselect options as desired. Dependencies between some 
features may force an installation option, even if you have deselected it.

9 At the Choose Features dialog box, click Rational RequisitePro and select the Oracle 
Setup or SQL Server Setup option if you plan to use one of those databases for your 
RequisitePro projects.
If you select either option, the program will install schema creation scripts in one 
or both of the following default locations on your local machine: 
c:\Program Files\Rational\RequisitePro\database\oracle

c:\Program Files\Rational\RequisitePro\database\sqlserver

For more information on configuring Oracle or SQL Server for RequisitePro 
projects, refer to Configuring Enterprise Databases on page 15.
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10 At the Software Use dialog box, select the option that corresponds to your 
intended use. For more information, refer to Software Use on page 5.

11 The Update Shared Components dialog box appears if the Rational Software Setup 
program needs to update some shared files or components on your system. Click 
Next to have Rational Software Setup install these files for you or Cancel to install 
these files yourself. For additional information, see Installing Shared Files on page 6 
or the Rational Software Setup online help.

Note:  The Rational Software Setup wizard does not recalculate the disk space 
required for your updated selections. 

12 The Upgrade Compatibility dialog box appears if you have older Rational 
products installed on your system. Because Rational tools share files and 
components, this installation can cause the older Rational products to stop 
working. You will see no visual clue to indicate that the older products may be 
compromised.

For each of the older products listed, we strongly recommend that you take one of 
the following actions:

❑ Upgrade it: Complete this installation, and then restart the Setup wizard to 
upgrade the next product. Upgrading a product updates all necessary files, 
registry entries, startup menu items, and shared components on your system.

❑ Remove it: Complete this installation, and then use the Control Panel's 
Add/Remove Programs tool to remove the next product. Removing a product 
deletes files, registry entries, and startup menu items from your system.

More information about interactions between specific products is available at the 
Web site http://www.rational.com/sitewide/support/index.jtmpl. Click Patches 
and Upgrades, and then click Upgrade Compatibility.

13 The Confirmation dialog box displays the product features that will be installed.

14 The Error Summary dialog box displays errors from the first part of the software 
installation. If the installation is successful, you will not see this dialog box.

The Rational Software Setup program writes a log of installation activities. The log 
file is located in <Install Path>\Rational\RSSetup\RSsetup.log.
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Possible Reboot Required

If files required for the installation are in use during the Rational Software Setup 
program, and if the program needs to install shared components on your system, the 
Setup program may require that you reboot your system. After rebooting, do the 
following:

1 Log on as the same administrator identity to complete the installation procedure. If 
you do not log on as the same administrator identity, the installation does not 
complete correctly. The installation process completes on your system.

2 Click Finish to exit from the Rational Software Setup program. 

Configuring E-mail for Discussions

Use the Rational E-mail Reader application to configure e-mail for all discussion 
participants with a valid e-mail address in their RequisitePro user information. The 
Rational E-mail Reader application is included with your Rational Software 
installation at the following default location: 
c:\Program Files\Rational\common\mailreader.exe

This application offers full e-mail integration with RequisitePro by associating an 
e-mail handler with each RequisitePro project. Initial discussion items and replies are 
automatically stored in the RequisitePro database and sent to discussion participants 
via e-mail. Participants can reply to the discussion items using their e-mail, as well as 
from within RequisitePro. 

Caution: The E-mail Setup option on the RequisitePro Tools menu only configures 
notification e-mail for users who initiate a discussion or reply to a discussion from 
within the RequisitePro Discussion dialog box. To allow users to reply to discussions 
via e-mail, and to enable discussion e-mail for RequisiteWeb users, configure an 
e-mail handler for each project using the Rational E-mail Reader.

Discussion E-mail Configuration Requirements  
� You must configure a unique e-mail address for each RequisitePro project

� For RequisiteWeb: You must run the Rational E-mail Reader on a different server 
than the Internet Information Services (IIS) server where RequisiteWeb is installed.

� For RequisitePro and RequisiteWeb: In order to enable e-mail for RequisiteWeb 
discussions, you must configure discussion e-mail using the SMTP protocol 
option in the Rational E-mail Reader. The MAPI protocol option is not supported 
for RequisitePro and RequisiteWeb.
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� In order to complete the Rational E-mail Reader setup for SMTP protocol, you 
need the following information from your e-mail administrator:
- SMTP Server name
- POP3 Server name
- E-mail address; one for each RequisitePro project
- POP3 server login and password for the e-mail address

� Be sure to specify a Log File Path on the Reader Information and Options tab in the 
Rational E-mail Reader.

Note:  Refer to the online help in the Rational E-mail Reader for more information. 

Removing RequisitePro

This section describes how to remove RequisitePro from your system.

Preparing to Remove RequisitePro

Make sure that no one is using RequisitePro and any associated files. You will not be 
able to remove files that are in use.

To remove RequisitePro from a Windows NT system, you must have Windows NT 
administrator privileges on the local machine.

To Remove RequisitePro

Use the Windows Add/Remove Programs control panel to select and remove 
RequisitePro. The Rational Software Setup removes RequisitePro from your system.

Note:  Removing RequisitePro does not remove RequisitePro project data from your 
system.

Note:  If you are upgrading to a new version of RequisitePro that uses a different 
installation path and you choose to leave the previous directories intact, you should 
delete the .gid files from your former help directories; for example: 
\Rational\RequisitePro 4.5\help\reqpro.gid 
This prevents the new RequisitePro help from looking in the old directories for its 
contents information.
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3Configuring Enterprise 
Databases 
This chapter describes how to configure Oracle® and Microsoft® SQL Server 
databases for RequisitePro projects. This information is also available in electronic 
format.

Note:  The use of client/server databases offers significantly increased power and 
expandability to your organization's implementation of Rational RequisitePro. 
RequisitePro can be used with Oracle7, Oracle8, Microsoft SQL Server 7.0, and 
Microsoft Access databases. The RequisitePro Database Type Conversion Wizard 
enables you to move a Rational RequisitePro project from one database to another. 

Database Setup

To create and access RequisitePro projects in Oracle or Microsoft SQL Server 
databases, you must configure an Oracle or SQL Server schema on your database 
server. Refer to Oracle or Microsoft documentation for information on installing 
Oracle or Microsoft SQL Server. To configure an Oracle or SQL Server database for 
RequisitePro projects, refer to the sections Configuring Oracle for RequisitePro on 
page 16 and Configuring SQL Server for RequisitePro on page 27. 

Client Installation

Access to RequisitePro projects on Oracle and SQL Server databases requires the 
installation of RequisitePro on the client PC. If you are using an Oracle database, you 
must also install the Oracle client software on your PC. 

See System and Software Requirements on page 2 for RequisitePro system requirements.

Installing Database Configuration Scripts 

If you are responsible for setting up an Oracle or SQL Server database for 
RequisitePro, you should have installed the database configuration scripts with the 
Custom/Full installation option, described in Installing RequisitePro with Rational 
Software Setup on page 9. 

If you selected the Oracle or SQL Server options, the program installed schema 
creation scripts in one or both of the following locations on your local machine: 
C:\Program Files\Rational\RequisitePro\database\oracle  

C:\Program Files\Rational\RequisitePro\database\sqlserver
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If you did not install the scripts during the installation process, you can copy them to 
your local machine from the RequisitePro/database directory on your installation 
media.

Configuring Oracle for RequisitePro

Purpose

This section provides information about configuring Rational RequisitePro for use 
with an Oracle database server. It includes:

� database management information for setting up an Oracle schema to 
accommodate Requisite projects, 

� instructions for accessing an Oracle host from the client PC using Oracle's 
SQL*Net or Net8 Easy Configuration tool, and

� a procedure for creating a RequisitePro project in the Oracle database.

These instructions are intended for use by Oracle database administrators, system 
administrators, and RequisitePro project administrators.

For the most current information related to Oracle database configuration, refer to the 
“Oracle Database Configuration for RequisitePro” document that is, by default, at the 
following location on your system after installation: 
C:\Program Files\Rational\RequisitePro\help\OracleSetup.html

Introduction

To create and access RequisitePro projects in the Oracle database, follow the 
instructions in this document for enabling your Oracle database compatibility. 
RequisitePro supports multiple projects within a single Oracle schema. Refer to 
Creating a Project in Oracle on page 24 for instructions on adding an Oracle database 
project within RequisitePro. Use the same schema name for each of your RequisitePro 
projects.

Prerequisites

This document assumes that you have Oracle installed on your LAN and the Oracle 
client software installed on your PC. Refer to the Oracle documentation for all 
questions regarding that product.

The following installation and configuration tasks must be accomplished prior to 
performing the RequisitePro/Oracle integration outlined in this document.
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Oracle Database Administration

Notice to database administrator: 
For proper execution of the RequisitePro application, be sure to set the initialization 
parameter, OPEN_CURSORS, to at least 110.

In order to configure access to Oracle for RequisitePro projects, the database 
administrator must establish the following:

� Oracle database server name (TCP/IP Host Name)

� Oracle database alias or service name

� Oracle schema name for storing RequisitePro projects (see procedure below)

� your user ID for logging on to the Oracle database

� your user password for logging on to the Oracle database

The following sections provide instructions for configuring the last three of these 
items.

Platform Compatibility

RequisitePro database implementation is compatible with all Oracle-supported 
platforms.

Creating an Oracle Schema for RequisitePro

Oracle database administration allows the creation of multiple schemas within your 
Oracle database instance. Use the scripts listed below to create a RequisitePro user 
and schema within Oracle for storing your projects. The RequisitePro scripts are 
designed to initially allocate disk space for the various database tables and indexes 
that are used by RequisitePro, based on the following approximations: 

� 25 projects

� 250 documents (10 per project)

� 125 document types (5 per project)

� 125 requirement types (5 per project)

� 1,250 user defined attributes (10 per requirement type)

� 125 user groups (5 per project)

� 100 users

� 12,500 requirements (500 per project)
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� 12,500 discussions (500 per project)

The scripts simply provide an initial size for the RequisitePro schema. They in no way 
imply any constraints on size or number of projects. 

Extents are set to the same size as the initial allocations. They define additional table 
space that Oracle will allocate if the original allocation becomes insufficient.

As database administrator, you can customize the scripts to adjust the table space 
allocations for tables and indexes in order to accommodate your organization's 
intended use of RequisitePro. See the section Editing Scripts on page 19.

Schema Creation Scripts

The following scripts are used for creating a RequisitePro schema within your Oracle 
database. They can be run automatically by executing the main script, 
CREATE_REQPRO, as described in the procedure Creating a Schema on page 21, or 
you can run them individually as needed.

CREATE_REQPRO. Establishes a log that can be used to review the results of 
running the script and runs the other scripts, listed below.  

TABLESPACE. Creates table spaces for data and indexes. Creates disk files to support 
these table spaces.

CREATE_USER. Creates the default RequisitePro user (REQPRO) and password 
(REQPRO) and connects to the database with that user ID.

TABLES.  Creates tables for the RequisitePro database.

PRIMARY. Creates primary keys for each table in RequisitePro.

INDEXES. Creates indexes for the RequisitePro database.

FOREIGN.  Creates foreign key relationships between tables.

FUNCTIONS. Creates customer-defined functions for use within RequisitePro.

SEQUENCE.  Creates sequences and triggers for auto-sequencing primary keys.

PROCEDURES. Creates stored procedures for use within RequisitePro.

DATA. Inserts data into the RqKeys and RqRequisite tables.

GRANT_ROLE. Creates a user role with access to the RequisitePro schema objects.
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Copying the RequisitePro Scripts

If you did not install the Oracle database creation scripts as described in Installing 
RequisitePro with Rational Software Setup on page 9, you can repeat the Custom/Full 
installation procedure or copy the Oracle scripts from the Rational Windows Solutions 
media in the following location:

CD-ROM:\\RequisitePro\database\Oracle\

After installation, the scripts are located, by default, at the following location on your 
local machine: 

C:\Program Files\Rational\RequisitePro\database\oracle

Copy the scripts to a subdirectory on your Oracle database server. We suggest that 
you create a “sql” directory below the home directory on the server.

Note:  If your database server is running on an international operating system, be sure 
that the path to these scripts does not include folders with double-byte character 
names.

Editing Scripts

All modifications described below are made in the CREATE_REQPRO script, unless 
otherwise indicated. 

Modifying the User Name and Password (Optional)

If you want to create the RequisitePro schema with a different entry than the default 
user name and password values of “ReqPro”, modify the following entries:

   DEFINE USR=reqpro

   DEFINE PWD=reqpro

Specifying the Path for the Schema Scripts

Edit the DEFINE PATH entry to indicate the full path where the RequisitePro SQL 
scripts are located. The suggested path (from “Copying the RequisitePro Scripts,"  
above) is: 

   DEFINE PATH="$HOME/sql/"

Note:  If your environment limits your path to a maximum 8-character name for 
directories, be sure to reflect this format in your entry.

Indicating Data and Index Files Directory

Edit the DEFINE ORACLE_DATA entry to indicate the path and directory where the data 
file for the data table space will be created:
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   DEFINE ORACLE_DATA=<full path>/ORACLE_DATA/

Edit the DEFINE ORACLE_INDEX entry to indicate the path and directory where the 
data file for the index table space will be created:

   DEFINE ORACLE_INDEX=<full path>/ORACLE_INDEX/

Specifying a Temporary Tablespace

Edit the DEFINE TEMP entry in the CREATE_REQPRO script to assign temporary 
tablespace for storing temporary objects for the user’s operations.

   DEFINE TEMP=TEMP

Make sure that the value for this entry is a valid, existing tablespace in your Oracle 
database. Some versions of Oracle use “TEMPORARY_DATA” rather than “TEMP.” 
Your installation of Oracle may contain a custom name for the temporary tablespace.

Customizing Disk Space Allocation for Database Objects

The schema creation scripts are designed to allocate disk space for the various 
database tables and indexes that are used by an average set of RequisitePro projects, 
as described in Creating an Oracle Schema for RequisitePro on page 17. 

If you anticipate a much larger or smaller requirement for your organization's use of 
RequisitePro, you can customize the disk space allocation specified in the 
CREATE_REQPRO script to accommodate your projected capacity. 

Edit the following sizing variables: 

   SMALL    = 10K

   MEDIUM   = 100K 

   LARGE    = 1000K

   REQS     = 6000K 

   REQHIST  = 75000K 

Note:  The last two variables, REQS and REQHIST, are used for the requirements 
(RqRequirements) and requirement history (RqRequirementHistory) tables, 
respectively.  

Edit the DEFINE DATA_SIZE and DEFINE INDEX_SIZE entries to reflect the change in 
the total size of the database caused by your edits to the sizing variables.

Modifying the Limits of the VARCHAR2 Data Type

RequisitePro uses the VARCHAR2 data type to store searchable text for requirement 
text, revision history reasons, and textual attribute values. 
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Although Oracle7 supports a maximum of 2,000 characters in the VARCHAR2 data 
type, Oracle8 supports up to 4,000, allowing you to expand the constraints on the size 
of the searchable text from 2,000 to 4,000 characters. 

The RequisitePro Oracle scripts set the limit on this data type to 2000 characters to 
accommodate both Oracle7 and Oracle8 databases. To modify this limit for Oracle8 
databases, increase the MAX_VARCHAR value in the CREATE_REQPRO script from 
2000 to a maximum of 4000. 

Creating a Schema

The Oracle database administrator performs the following procedure to create a 
RequisitePro schema in Oracle:

1 Edit the CREATE_REQPRO script, as described above in the section Editing Scripts 
on page 19.

2 On the Oracle database server, log on to SQL*Plus with system administrator 
permissions.

Note:  If you run SQL*Plus from a remote client, you need to edit the RequisitePro 
CREATE_USER script. Change the entry connect &3/&4 to the following:
connect &3/&4@<target Oracle database server alias>

3 Run the CREATE_REQPRO script using the command:
@<setup directory>\CREATE_REQPRO

This script runs the schema creation scripts. A message appears upon successful 
completion of the schema creation. If errors occur or the completion message does not 
appear, review the log CREATE_REQPRO.LOG.

User ID for Accessing Oracle Database

All RequisitePro projects should access the Oracle database using the same user ID, 
which was created during the schema creation process, described above. The initial 
user name and password created by the script are "reqpro" and "reqpro", unless you 
modified the CREATE_REQPRO script, as described in Editing Scripts on page 19. You 
can also change the password using your Oracle database utilities. 

Each user does not need a separate Oracle account because RequisitePro uses its own 
user and user group tables to control access to a project.
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Using Multiple Projects within an Oracle Database

RequisitePro supports multiple projects within a single Oracle schema. Refer to the 
procedure Creating a Project in Oracle on page 24 for instructions on adding an Oracle 
database project within RequisitePro. Use the same schema name for each of your 
RequisitePro projects.

Connecting Projects Across Databases

Perform the following steps to enable cross-project traceability between projects in 
distributed Oracle databases. Refer to the following sections for details.

� Creating a reference to the remote database instance

� Creating a database link to the remote database

� Defining database aliases on each RequisitePro client

Creating a reference to the remote database instance

In order to run traceability queries between projects in distributed Oracle databases, 
you need to define a reference in each database instance that refers to the remote 
database instances. Edit the tnsnames.ora file, located on the Oracle server, to define 
the name, host, port, and protocol of the remote service. 

The following example shows the syntax for defining the database instance 
“server02” as a remote database server to “server01” in the tnsnames.ora file:

Server02.world = 
  (DESCRIPTION = 
    (ADDRESS_LIST =
      (ADDRESS = 
          (COMMUNITY = tcp.world)
          (PROTOCOL = TCP)
          (Host = server02)
          (Port = 1521)))
    (CONNECT_DATA = (SID = ORCL)))

In similar fashion, the “server02” database instance needs an entry to define the 
remote “server01” database instance:

Server01.world = 
  (DESCRIPTION = 
    (ADDRESS_LIST =
      (ADDRESS = 
          (COMMUNITY = tcp.world)
          (PROTOCOL = TCP)
          (Host = server01)
          (Port = 1521)))
    (CONNECT_DATA = (SID = ORCL)))
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Note:  This feature was tested using TNSNAMES for service name resolution. Use of 
Oracle Names Server or any other name server mechanism requires a different setup.

Creating a database link to the remote database

Next, create a database link to each remote database in each database instance using a 
SQL utility. The link should be defined under the user account that owns the 
RequisitePro schema. The following example shows the required syntax for linking to 
“server02” from “server01”:

   CREATE DATABASE LINK server02.world

   CONNECT TO reqpro IDENTIFIED BY reqpro

   USING ‘server02.world’;

A similar statement should be executed on the server02 database instance in order to 
define a link to server01.

If the db_name.db_domain does not result in a unique name for each database for 
which a link is required, use the @connection_qualifier syntax to create a unique 
name.

This naming convention will work regardless of the setting of the global_names 
parameter in the initorcl.ora file.

Defining database aliases on each RequisitePro client

Define SQL*Net database aliases or Net8 service names (resulting in local 
tnsnames.ora file entries) on each RequisitePro client machine (or shared centrally on 
a network) for each database instance. The database alias or service name on the client 
MUST match the database link you defined in the previous step for RequisitePro 
cross-project traceability to function correctly. 

For more information on configuring client PCs for use with a Rational RequisitePro 
Oracle database, refer to the following section.

Setting Up PCs for Oracle Access

Use the Oracle SQL*Net or Net8 Easy Configuration tool to configure access from 
your client PC to the Oracle database server. If you plan to share projects with other 
users, be sure to use a consistent database alias or service name, as determined by 
your database administrator.
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Creating a Project in Oracle
Note:  To convert a project from an existing Microsoft Access database to an Oracle 
database, use the Database Type Conversion Wizard. Open the Database Type 
Conversion Wizard in Windows Explorer. The executable, rqdbtypewiz.exe, is 
located in the directory: \Program Files\Rational\RequisitePro\bin\ 

Perform the following steps to create a RequisitePro project that uses the Oracle 
database server for storing the RequisitePro project database.

In order for you to configure your access to Oracle from RequisitePro, the database 
administrator must provide the following information:

� Oracle database server name (TCP/IP Host Name)

� Oracle database alias or service name

� Oracle schema name for storing RequisitePro projects (see procedure below)

� your user ID for logging on to the Oracle database

� your user password for logging on to the Oracle database

1 In RequisitePro on the Project menu, click New. The Create RequisitePro Project 
dialog box appears.

2 Select a project template.

Note:  The details in the lower part of the dialog box provide an explanation as you 
select each template.

3 Click Create. The Rational RequisitePro Project Properties dialog box appears.
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4 Enter a project name and directory location.

5 At the Database field, select Oracle from the drop-down list and click the 
Properties button. The Database Properties dialog box appears.

6 Click the Configure button. The Microsoft ODBC for Oracle Setup dialog box 
appears.

  

7 Do not modify the default entries in the Data Source Name and Description 
fields.

8 Type your User Name for logging into the Oracle database, as provided by your 
Oracle database administrator. By default, the user name is "reqpro".

9 For the Server field, type the alias or service name you entered when configuring 
your PC for access to the Oracle database.

Note:  This database alias or service name must be identical when configuring all 
PCs that will access shared RequisitePro projects in the Oracle database.

10 Click OK. The Database Properties dialog box appears.

11 Click the Account Info button. The Database Account Info dialog box appears.
  

12 Do not modify the User ID field. This should match the user name you entered in 
the previous dialog box. 

reqpro
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13 Type your user password for logging into the Oracle server. This should be 
supplied to you by your Oracle database administrator.

14 Retype your password in the Verify Password field.

15 In the Schema field, type the name of the Oracle schema that your Oracle 
database administrator has established for storing RequisitePro data in Oracle.

16 Click OK to close the Database Account Info dialog box. Click OK to close the 
Database Properties dialog.

17 Finish creating your project, then click OK to close the Project dialog box.

Archiving and Baselining an Oracle Project

Refer to the topics “Archiving enterprise database projects” and “Baselining projects 
with Unified Change Management” in the RequisitePro online help. These help topics 
are also available in Let’s Go RequisitePro. Click the Project Administration Tips icon 
and select the appropriate link.
26 Chapter 3 - Configuring Enterprise Databases



Configuring SQL Server for RequisitePro

Purpose

This section provides information about configuring Rational RequisitePro for use 
with Microsoft SQL Server. The section includes:

� database management information for setting up a SQL Server schema to 
accommodate RequisitePro projects

� a procedure for creating a RequisitePro project in the SQL Server database

This document is intended for use by SQL Server database administrators, system 
administrators, and RequisitePro project administrators.

For the most current information related to SQL Server database configuration, refer 
to the document “SQL Server Database Configuration for RequisitePro” that is, by 
default, at the following location on your system after installation: 
C:\Program Files\Rational\RequisitePro\help\SQLsetup.html

Introduction

To create and access RequisitePro projects in the SQL Server database, follow the 
instructions in this section for enabling your SQL Server database compatibility. 
RequisitePro supports multiple projects within a single SQL Server schema. Refer to 
the procedure Creating a Project in SQL Server on page 31 for instructions on adding an 
SQL Server database project within RequisitePro. Use the same schema name for each 
of your RequisitePro projects.

Prerequisites

This document assumes that you have SQL Server, Version 7.0, installed on your 
LAN. Refer to the SQL Server documentation for all questions regarding that product.

Note:  If you have an existing RequisitePro database in SQL Server, and your SQL 
Server software has been upgraded to version 7.0 from a previous version, then you 
must run the following stored procedure in SQL Server to set the database 
compatibility level to SQL Server 7.0:

sp_dbcmptlevel <database name>, 70

for example: 

sp_dbcmptlevel RequisitePro, 70

The above procedure is required to prevent SQL Server Syntax Errors in RequisitePro.
Configuring SQL Server for RequisitePro 27



The following installation and configuration tasks need to be accomplished prior to 
performing the RequisitePro/SQL Server integration outlined in this document.

SQL Server Database Administration

Prior to configuring your access to SQL Server from RequisitePro, the database 
administrator must establish the following:

� SQL Server machine name (TCP/IP Host Name)

� SQL Server default database for RequisitePro projects, such as “RequisitePro”

� a user ID for logging on to the SQL Server database, such as “ReqPro”

� a user password for logging on to the SQL Server database, such as “reqpro”

The following sections provide instructions for configuring the last three of these 
items.

Platform Compatibility

RequisitePro database implementation is compatible with all Microsoft SQL 
Server-supported platforms.

Creating a SQL Server Database for RequisitePro 

Use the following instructions to create a SQL Server database and schema for 
RequisitePro projects. The initial database size is based on the following 
approximations for your use of RequisitePro: 

� 25 projects

� 250 documents (10 per project)

� 125 document types (5 per project)

� 125 requirement types (5 per project)

� 1,250 user-defined attributes (10 per requirement type)

� 125 user groups (5 per project)

� 100 users

� 12,500 requirements (500 per project)

� 12,500 discussions (500 per project)
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To create a database in SQL Server 7.0, do the following:

1 Enter a name for the RequisitePro database. The database has an .MDF extension. 
The recommended database name is “RequisitePro.”

Note:  If you use a different database name, you will need to modify the database 
configuration scripts to reflect the actual name.

2 Set the initial size of the database to 150 MB.

3 Set the initial size of the transaction log file (.LDF) to one third the size of the 
database (in this case, 50 MB).

Schema Creation Scripts

The scripts listed below are used for creating a RequisitePro schema within your SQL 
Server database. 

� Login and User. Creates a default RequisitePro login and user. For more 
information refer to the section below, “Default Login and User.” 

� Tables and Indexes. Creates the tables and indexes required by RequisitePro.

� Triggers. Creates triggers that enforce cascading deletes.

� Initial Data. Inserts data required by RequisitePro when it first runs.

Copying the RequisitePro Scripts

If you did not install the SQL Server database creation scripts as described in Installing 
RequisitePro with Rational Software Setup on page 9, you can repeat the Custom/Full 
installation procedure or copy the SQL Server scripts from the Rational Windows 
Solutions media in the following location:

CD-ROM:\\RequisitePro\database\SQLserver\

After installation, the scripts are located, by default, at the following location on your 
local machine:  

C:\Program Files\Rational\RequisitePro\database\sqlserver  

Copy the scripts to a subdirectory on your SQL Server database server. We suggest 
that you create a “sql” directory below the home directory on the server.
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Running Schema Creation Scripts

The scripts listed below are used for creating a RequisitePro schema within your SQL 
Server database. Run the scripts in the sequence presented below. Run the scripts 
individually using the SQL Server Query Analyzer. Be sure to select the RequisitePro 
database in the DB drop-down list when running the scripts.

1 login and user.sql   

2 tables and indexes.sql 

3 triggers.sql  

4 initial data.sql

Default Login and User

The schema creation scripts, described above, create default user information for 
accessing and creating projects in SQL Server. The user name also establishes the 
ownership and name of the schema (by default, “reqpro”). The default user 
permissions are required for use with RequisitePro.

Note:  If you modify the login and user.sql script to use a different login and user 
name, you will need to modify subsequent scripts.

The scripts create the following default user information:

The ReqPro user is assigned the following statement permissions in SQL Server:

User Login Password

ReqPro ReqPro reqpro

User Statement Permissions

ReqPro Create Default, Create Procedure, Create Rule, 
Create Table, Create View
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As the owner of the RequisitePro database objects, the ReqPro user is automatically 
assigned the following database permissions in SQL Server:

Creating a Project in SQL Server
Note:  To convert a project from an existing Microsoft Access database to an Oracle 
database, use the Database Type Conversion Wizard. Open the Database Type 
Conversion Wizard in Windows Explorer. The executable, rqdbtypewiz.exe, is 
located in the directory: \Program Files\Rational\RequisitePro\bin\ 

Perform the following steps to create a RequisitePro project that uses the SQL Server 
for the project database.

In order to configure access to SQL Server from RequisitePro, the database 
administrator must provide you with the following information:

� SQL Server machine name (TCP/IP Host Name)

� SQL Server default database for RequisitePro projects, such as “RequisitePro”

� a user ID for logging on to the SQL Server database, such as “ReqPro”

� a user password for logging on to the SQL Server database, such as “reqpro”

1 Start RequisitePro. In RequisitePro on the Project menu, click New. The Create 
RequisitePro Project dialog box appears.

2 Select a project template.

Note:  The details in the lower part of the dialog box provide an explanation as you 
select each template.

User Database Permissions

ReqPro Select, Insert, Update, Delete, DRI on all Tables 
and Views
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3 Click Create. The Rational RequisitePro Project Properties dialog box appears.

4 Enter a project name and directory location.

5 At the Database field, select SQL Server from the drop-down list.

6 Click the Properties button. The Database Properties dialog box appears.
  
32 Chapter 3 - Configuring Enterprise Databases



7 At the Database Properties dialog box, click the Configure button. The “Create a 
New Data Source to SQL Server” dialog box appears.

  

8 Do not modify the data source Name or Description fields. In the Server field, 
type the name of the SQL Server, supplied by your database administrator.

9 Click Next. The second data source screen appears.
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10 Select the option With SQL Server authentication using a login ID and 
password entered by the user.

Note:  RequisitePro does not support Windows NT authentication.

11 Be sure the check box Connect to SQL Server to obtain default settings for the 
additional configuration options is checked.

12 Type the login ID and password supplied by your database administrator, such as 
“ReqPro” and “reqpro.” Click Next.

13 Click the check box Change the default database to and select a database name 
supplied by your database administrator, such as “RequisitePro.” Click Next.

14 Click Next to accept the default language, character, and regional settings. The use 
of log files, shown on the following screen, is optional.

Note:  Do not select the check box Change the language of SQL Server system 
messages to... Selecting this check box prevents users from opening the project 
after its initial creation.

15 Click Finish. The ODBC Microsoft SQL Server Setup dialog box appears.

16 Click the Test Data Source button. The SQL Server ODBC Data Source Test dialog 
box appears.

17 Click OK. The ODBC Microsoft SQL Server Setup dialog box appears.

18 Click OK. You return to the Database Properties dialog box.

19 At the Database Properties dialog box, click the Account Info button. The 
Database Account Info dialog box appears.

  

20 Type the User ID and Password, supplied by your database administrator for 
accessing the SQL Server database, such as “ReqPro” and “reqpro.”

21 Retype your password in the Verify Password field.
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22 In the Schema field, type the user name of the owner of the RequisitePro database 
tables, supplied by your database administrator, such as “ReqPro.”

23 Click OK to close the Database Account Info dialog box. Click OK to close the 
Database Properties dialog box.

24 Finish creating your project, then click OK to close the Project dialog box.

Archiving and Baselining an SQL Server Project

Refer to the topics “Archiving enterprise database projects” and “Baselining projects 
with Unified Change Management” in the RequisitePro online help. These help topics 
are also available in Let’s Go RequisitePro. Click the Project Administration Tips icon 
and select the appropriate link.
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4Installing and 
Configuring Rational 
RequisiteWeb 

Introduction

Rational RequisiteWeb allows clients to read, create, and modify Rational 
RequisitePro project requirements across an intranet. By utilizing browsers – Netscape 
Navigator or Microsoft Internet Explorer – RequisiteWeb provides 
platform-independent, thin-client access to RequisitePro project data. 

This chapter contains the following sections:

� RequisiteWeb System Requirements

� Key Components Overview 

� Single-Server Configuration Overview 

� Dual-Server Configuration Overview 

� Configuring the RequisiteWeb Requirements Server 

� Setting Up the Single-Server Configuration 

� Setting Up the Dual-Server Configuration 

� Managing RequisitePro Projects for RequisiteWeb 

� Configuring E-mail for Discussions 

� Starting RequisiteWeb 

� Removing RequisiteWeb 

For the most current information on RequisiteWeb, including  installation, 
configuration, and known issues, refer to the RequisiteWeb Installation and 
Configuration document that is on the Rational Solutions for Windows CD at:
\RequisitePro\ReqWeb\reqwebsetup.html
It is also located, by default, in your RequisiteWeb installation at: 
C:\Program Files\Rational\RequisitePro\ReqWeb\reqwebsetup.html

The RequisiteWeb Installation and Configuration document is also available from the 
online Release Notes in RequisitePro.
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RequisiteWeb System Requirements

Server Requirements

The following table summarizes the requirements for the RequisiteWeb server.

Table 8 RequisiteWeb Server Requirements

Item Web Server
Requirements Server or 
Single Server

Operating 
System/

Sun Microsystems Solaris 8
Red Hat Linux

One of the following:
� Microsoft Windows 2000 Advanced 

Server
� NT Server 4.0, Service Pack 6A or 

later; NT 4.0 Option Pack

HTTP 
Server

Apache Web Server One of the following:
� Internet Information Server (IIS) 4.0 

and Microsoft Transaction Server 
(MTS) 2.0

� Internet Information Services (IIS) 
5.0 

Processor Intel processor: 400 MHz or greater

For the Solaris OS: Sun SPARCstation

400 MHz or greater

Memory 128 MB 128 MB. For projects with more than 
10,000 requirements or Web sites with 
more than 10 concurrent users, 256 
MB or more is recommended.

Disk space JSPs, Web DLLs, bitmaps -- 2 MB RequisiteWeb (includes system DLLs) 
-- 40 MB
38 Chapter 4 - Installing and Configuring Rational RequisiteWeb



RequisiteWeb Security Requirements

After you have installed RequisiteWeb, you may need to alter security permissions on 
your server for reasons unrelated to RequisiteWeb. Use caution when modifying 
permissions on RequisiteWeb-related folders. For more information, see Editing the 
RequisiteWeb Configuration File on page 62 and Configuring the RequisiteWeb 
Requirements Server on page 44.

Client Requirements

To access RequisiteWeb from client machines, you must install one of the following 
Web browsers on the client system. No additional client installation is required for use 
of RequisiteWeb.

� Microsoft Internet Explorer 4.X or 5.X

� Netscape Navigator 4.X (Win 95/98/NT, UNIX)
As of this printing, Netscape 6 Preview Release has not been fully qualified for 
compatibility with RequisiteWeb.

Note:  For proper RequisiteWeb operation, you must set your browser to allow 
cookies.

Other 
products

� Sun Microsystems Java 
Development Kit (JDK 1.2.2)

� ANSI-C compiler such as GNU's 
gcc package

� WinZip utility.
� Microsoft Word 2000 

Note: Microsoft Word licenses are 
required for all RequisiteWeb end 
users.

� Oracle, version 7.3 or greater, client 
software (for accessing projects in 
an Oracle database).

� Microsoft Internet Explorer 5, 
or Internet Explorer 4 with the XML 
parser available at 
http://msdn.microsoft.com/
downloads/tools/xmlparser/
xmldl.asp

� Sun Microsystems Java 
Development Kit (JDK 1.2.2)

Table 8 RequisiteWeb Server Requirements
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Key Components Overview

The following sections describe key components in the RequisiteWeb installation. 
They include components on both the Web server and the Requirements server.

Java Development Kit 

The Sun Microsystems Java Development Kit (JDK) is a development and 
deployment environment that includes key components for your RequisiteWeb 
implementation. The Java Runtime Environment (JRE) contain binary libraries 
required for the execution of Java scripts and servlets. The Java Virtual Machine (JVM) 
interprets and implements the Java programming language in the Web server 
configuration. 

Tomcat Servlet Engine 

Tomcat is an implementation of the Java Servlet 2.2 and Java Server Pages (JSP) 1.2 
Specifications. Tomcat is produced by the Jakarta Project, which is composed of 
members of the Apache Jserv Project, engineers from major corporations such as Sun 
and IBM, newer companies like Exoffice, and individual developers. 

Tomcat is a servlet container with a JSP environment. A servlet container is a runtime 
shell that manages and invokes servlets on behalf of users. As an in-process servlet 
container, Tomcat is a combination of a Web server plugin and a Java container 
implementation. The Web server plugin opens a Java Virtual Machine (JVM) inside 
the Web server's address space and lets the Java container run in it. If there is a request 
to execute a servlet, the plugin takes control of the request and passes it to the Java 
container.

Note:  This document assumes that you have not installed Tomcat on your server. If 
you are already running Tomcat, verify that you have version 3.1. If this is the case, 
note the path of your current Tomcat installation, and skip the Tomcat installation 
procedure in this document.

Microsoft Word 2000

In order to access RequisitePro requirements documents in RequisiteWeb, Microsoft 
Word 2000 must be installed on the single RequisiteWeb Server, as described in 
Single-Server Configuration Overview; or, when configuring an Apache Web server, 
Word must be installed on the Requirements server, as described in Dual-Server 
Configuration Overview on page 42. For Microsoft Word version information, see 
RequisiteWeb System Requirements on page 38.
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Single-Server Configuration Overview

When running Microsoft Internet Information Server (IIS), version 4 or 5, as your Web 
server, you can configure your entire RequisiteWeb implementation on a single server. 
This implementation requires the use of Windows NT 4.0 or Windows 2000 Server as 
your operating system.

The single RequisiteWeb Requirements server configuration requires the installation 
of the components described in Key Components Overview on page 40. In addition, it 
includes the RequisiteWeb components: RequisitePro Extensibility Interface (RPX), 
RequisiteWeb JSP and HTML files, a RequisitePro project catalog file, Microsoft Word, 
and access to a project database. The following figure shows the single-server 
configuration:

Note:  The single-server configuration cannot be implemented on a Primary Domain 
Controller or Backup Domain Controller, because RequisiteWeb uses a local user to 
generate documents.

For instructions on configuring the single server, see Setting Up the Single-Server 
Configuration on page 54.
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Dual-Server Configuration Overview

When using Linux or Sun Microsystems Solaris for the operating system on your Web 
server, you must configure RequisiteWeb on two servers:

� The Web server hosts the primary login URL for RequisitePro, all Java Server 
pages, and the HTML pages that present the user interface for RequisiteWeb. It 
includes utilities for compiling Java objects and routing information to and from 
the Requirements server. This server can run on Sun Microsystems Solaris OS, Red 
Hat Linux and use the Apache Web server; alternatively, this server can run 
Microsoft NT or Windows 2000 Server and use Microsoft Internet Information 
Server (IIS), version 4 or 5. 

Note:  When running IIS, you can also choose to configure RequisiteWeb on a 
single server, as described in Single-Server Configuration Overview on page 41.

� The Requirements server hosts the RequisitePro Extensibility Interface, the 
RequisitePro project catalog, Microsoft Word, and processing software for passing 
information to and from the Web Server and the RequisitePro project database. 
This server runs on Microsoft NT or Windows 2000 and uses Microsoft Distributed 
COM (DCOM). RequisiteWeb offers secure access to RequisitePro project 
information; access to specific project folders should be enabled on NTFS file 
systems.

Note:  The Requirements server cannot be implemented on a Primary Domain 
Controller or Backup Domain Controller, because RequisiteWeb uses a local user 
to generate documents.
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The following diagram presents key components of the RequisiteWeb installation on 
two servers:

For instructions on implementing the dual-server configuration, see Setting Up the 
Dual-Server Configuration on page 65.

RequisitePro Proxy 

RequisitePro Proxy is an executable file that is installed on the Requirements server 
with the other RequisiteWeb components. It receives requests from DCOM and 
instantiates the required RequisiteWeb component, such as the Requisite Extensibility 
Interface (RPX), the RequisitePro project catalog, and Microsoft Word. Proxy passes 
requests to the active component and processes the returned data collection, passing 
the data back to DCOM.

You will configure the Proxy Connector class (RqProxy.Connector) in Microsoft 
DCOM to assign proper permissions to the RequisiteWeb user (ReqWeb_RPXUser).
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Configuring the RequisiteWeb Requirements Server 

Note:  Unless otherwise indicated, this entire section applies to both single-server and 
dual-server RequisiteWeb configurations. 

These instructions assume that you have installed the Microsoft Internet Information 
Server (IIS) on your RequisiteWeb Requirements server and that it is running. For 
more information on IIS, see Microsoft Servers at www.microsoft.com/servers.

This section describes installation and configuration of the RequisiteWeb components 
on the Requirements server. Details for the following procedures are provided: 

� Installing RequisiteWeb components from the Rational Software Solutions CD.

� Creating a domain user and a local user with administrative permissions.

� Assigning DCOM configuration permissions for RequisiteWeb components and 
Microsoft Word.

� Creating a document directory.

� Installing Oracle client software.

Installing RequisiteWeb on the Requirements Server
Note:  For current RequisiteWeb users, be sure to uninstall any earlier version of 
RequisiteWeb prior to installing the current release of RequisiteWeb on your server. 
Do not remove your ReqWeb virtual directory; instead, redirect it to the components 
in your new RequisiteWeb installation. Refer to Removing RequisiteWeb on page 78 for 
specific instructions. Be sure to retain your existing catalog.txt file.

Note:  To install RequisiteWeb, you must have a Rational license key. You can acquire 
and import the Rational license keys before or after installing Rational RequisitePro. 
See the Administering Licenses for Rational Software manual for more information about 
licenses, including the procedure for obtaining a license key. If you install 
RequisiteWeb as part of a Rational Suite, you must select the appropriate Suite license 
usage order. In the Rational License Administrator, click Settings > License Usage 
Mapper.

1 Log on to the RequisiteWeb Requirements server as an administrator.

2 Insert the Rational Solutions for Windows CD into your system’s CD drive. The 
setup program starts automatically. If autorun is disabled on your system, click 
Start  >  Run. Using the drive letter of your CD-ROM drive, enter 
drive:\SETUP.EXE.
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3 The Rational Software Setup wizard guides you through the software installation. 
On each screen, click the Next button to proceed to the next screen. The Rational 
Software Setup program writes a log of the installation activities. The log file is 
located, by default, in C:\Program Files\Rational\RSSetup\RSSetup.log

4 At the Choose Product screen, select Rational RequisitePro on the drop-down list.

5 At the Setup Configuration screen, click Custom/Full. 

Note:  If your database server is running on an international operating system, be 
sure that the install path does not include folders with double-byte character 
names.

6 At the Choose Features screen, select the Web Server Components check box.

7 Select or clear the following optional check boxes:

❑ If you plan to use this machine for creating and managing RequisitePro 
projects, leave the RequisitePro check box selected. If you plan to use this 
machine only for hosting RequisiteWeb, you can clear it.

❑ Leave the Rational Synchronizer check box unmarked. 

❑ The Sample Projects option, under the expanded RequisitePro options, allows 
you to include the RequisitePro Learning Project and QuarterByte Bank 
example projects. These projects are helpful for testing and learning 
RequisiteWeb.

❑ The Oracle Setup and SQL Server Setup options are required for database 
administrators who are configuring Oracle or SQL Server databases for 
RequisitePro projects.

Possible Reboot Required

If files that are required for the installation are in use during the installation 
procedure, the Rational Windows Setup program may require that you reboot your 
system to complete the installation.

After rebooting, log on as the same user to complete the installation procedure.
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Creating the RequisiteWeb Users

RequisiteWeb requires that you create two administrative users:

� a domain user, ReqWeb_RPXUser, for accessing RequisiteWeb components

� a local user, ReqWeb_WordUser, for launching Microsoft Word

Creating the RPX User on the Domain Server
Note:  Be sure to log on to your domain server as an administrator for the following 
procedure.

Create the ReqWeb_RPXUser as a domain user on your domain server.

Table 9 Creating a Domain User 

Step NT 4.0 Windows 2000 Server

1 On the domain server, click Start > 
Programs > Administrative Tools (Common) > 
User Manager for Domain.

On the domain server, click Start > Programs 
> Administrative Tools > Computer Management.

2 Click User > New User. Expand Domain Users and Groups. Right-click 
on Users; select New User.

3 In the Username field, type 
ReqWeb_RPXUser
and enter a password of your choice.

In the Username field, type 
ReqWeb_RPXUser
and enter a password of your choice. 

4 Clear the check box User must change 
password at next login and select the check 
box Password never expires. Click Add; 
click Close.

Clear the check box User must change 
password at next login and select the check box 
Password never expires. Click Create; click 
Close.

5 Close the User Manager application. Close the Computer Management 
application.
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Adding the RPX User to the Requirements Server Administrators
Note:  Be sure to log on to your RequisiteWeb Requirements server as an administrator 
for the following procedure.

Add the ReqWeb_RPXUser user to the Administrators group on your RequisiteWeb 
Requirements server.

Note:  If any of your RequisitePro projects are located on a server other than the 
RequisiteWeb Requirements server, the ReqWeb_RPXUser must have Change or 
Modify permission for the directory containing the RequisitePro .rqs project file on 
the remote project server. For more information, see Managing RequisitePro Projects for 
RequisiteWeb on page 76.

Assigning DCOM Permissions for the RPX User
Note:  If you are implementing a single-server configuration of RequisiteWeb, skip to 
Creating the Word User on page 50.

In this procedure, you set appropriate permissions in Microsoft Distributed COM 
(DCOM) for the RequisiteWeb in-process object server user (ReqWeb_RPXUser) to 
ensure necessary access to RequisitePro components and project databases. 

Table 10 Adding the RPX User to the Local Administrators 

Step NT 4.0 Windows 2000 Server

1 On the Requirements server, click Start > 
Programs > Administrative Tools > User 
Manager.

On the Requirements server, click Start > 
Programs > Administrative Tools > Computer 
Management.

2 Click User > Select Domain and select your 
domain server.

Expand Local Users and Groups. Select Groups.  
Right-click Administrators and select Add to 
Group. In the Administrators Properties 
dialog box, click Add.

3 Select the ReqWeb_RPXUser and click 
User > Properties. 

At the Look in field, select the domain. 

4 Click Groups,  and add the 
Administrators group to the Member of 
list. Click OK.

Select the ReqWeb_RPXUser and click Add. 
Click OK.

5 Close the User Manager application. Close the Computer Management 
application.
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Specifically, you will allow this user access to the RequisiteWeb Proxy executable, 
which is required for processing RequisitePro project information on the 
Requirements server.

Use DCOM to give the ReqWeb_RPXUser user access, launch, and read permissions 
for RQProxy.Connector. Set the identity to the ReqWeb_RPXUser user.  The following 
sections provide detailed instructions for these procedures.

Assigning Access Permissions for the RPX User

1 On the Start menu, click Run, and type dcomcnfg

2 In the list of applications, select RqProxy.Connector and click Properties. The 
RqProxy.Connector Properties dialog box appears.

3 On the Security tab, click Use custom access permissions. Click the adjacent Edit 
button. 

4 At the Registry Value Permissions dialog box, click Add. 

5 At the Add Users and Groups dialog box, click the List Names From field and select 
your domain. Click Show Users.

6 Select the ReqWeb_RPXUser entry and click Add.

7 At the Type of Access field, select Allow Access. Click OK twice to return to the 
RqProxy.Connector Properties dialog box.

8 Continue with the next procedure.

Assigning Launch Permissions for the RPX User

1 On the Security tab of the RqProxy.Connector Properties dialog box, click Use 
custom launch permissions. Click the adjacent Edit button.

2 At the Registry Value Permissions dialog box, click Add. 

3 At the Add Users and Groups dialog box, click the List Names From field and select 
your domain. Click Show Users.

4 Select the ReqWeb_RPXUser entry and click Add. 

5 At the Type of Access field, select Allow Launch. Click OK twice to return to the 
RqProxy.Connector Properties dialog box.

6 Continue with the next procedure.
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Assigning Configuration Permissions for the RPX User

1 On the Security tab of the RqProxy.Connector Properties dialog box, click Use 
custom configuration permissions. Click the adjacent Edit button.

2 At the Registry Value Permissions dialog box, click Add. 

3 At the Add Users and Groups dialog box, click the List Names From field and select 
your domain. Click Show Users.

4 Select the ReqWeb_RPXUser entry and click Add. 

5 At the Type of Access field, select Read. Click OK twice to return to the 
RqProxy.Connector Properties dialog box.

6 Continue with the next procedure.

Assigning Identity for the RPX User

1 At the RqProxy.Connector Properties dialog box, click the Identity tab.

2 Click This user and click Browse. Click the List Names From field and select your 
domain. Select the ReqWeb_RPXUser entry. Click Add and OK.

3 Enter and confirm the ReqWeb_RPXUser password that you defined when you 
created this user.

4 Click OK again to return to the Distributed COM Configuration Properties dialog 
box.

5 Close DCOM.
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Creating the Word User 

RequisiteWeb requires a local administrative user for launching Microsoft Word 2000 
on the RequisiteWeb Requirements server. Create the ReqWeb_WordUser and add 
that user to the Administrators group, as described in the following instructions.

Assigning DCOM Permissions for the Word User

RequisiteWeb uses the Distributed Component Object Model (DCOM) and a local 
user with Administrator permissions to launch Microsoft Word.

Table 11 Creating a User for Launching Word

Step Windows NT 4.0 Windows 2000 Server

1 Click Start > Programs > Administrative 
Tools > User Manager.

Click Start > Programs > Administrative Tools > 
Computer Management.

2 Click User > New User. Expand Local Users and Groups and 
right-click on Users; select New User.

3 In the Username field, type 
ReqWeb_WordUser and enter a 
password of your choice.

In the User name field, type 
ReqWeb_WordUser and enter a password 
of your choice.

4 Clear the check box User must change 
password at next login and select the check 
box Password never expires. 

Click Add; click Close.

Clear the check box User must change 
password at next login and select the check box 
Password never expires.

Click Create; click Close.

5 At the User Manager dialog box, select 
the ReqWeb_WordUser and click User > 
Properties.

Select Users. Right-click the 
ReqWeb_WordUser entry and select 
Properties.

6 At the User Properties dialog box, click 
Groups.

At the Member Of tab, click Add. 

7 At the Group Memberships dialog box, 
add the Administrators group to the 
Member Of list. Click OK.

Select the Administrators group, and click 
Add. Click OK.

8 Close the User Manager dialog box. Close the Computer Management dialog 
box.
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Use DCOM to give the ReqWeb_WordUser user access and launch permissions for 
Microsoft Word and Microsoft Word Basic, if it appears in your DCOM application 
list.  The following sections provide detailed instructions for these procedures.

Assigning Access Permissions for the Word User

1 On the Start menu, click Run, and type dcomcnfg

2 On the Applications tab, select Microsoft Word Document on the list of applications 
and click Properties. 

3 On the Security tab, click Use custom access permissions. Click the adjacent Edit 
button. 

4 At the Registry Key Permissions dialog box, click Add. 

5 At the Add Users and Groups dialog box, click the List Names From field and select 
your local server. Click Show Users.

6 Select the ReqWeb_WordUser entry and click Add.

7 At the Type of Access field, select Allow Access. Click OK twice to return to the Word 
Document Properties dialog box.

8 Continue with the next procedure.

Assigning Launch Permissions for the Word User

1 On the Security tab of the Microsoft Word Document Properties dialog box, click 
Use custom launch permissions. Click the adjacent Edit button.

2 At the Registry Value Permissions dialog box, click Add. 

3 At the Add Users and Groups dialog box, click the List Names From field and select 
your local server. Click Show Users.

4 Select the ReqWeb_WordUser entry and click Add. 

5 At the Type of Access field, select Allow Launch. Click OK twice to return to the Word 
Document Properties dialog box.

6 Continue with the next procedure.
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Assigning Identity for the Word User

1 At the Microsoft Word Document Properties dialog box, click the Identity tab.

2 Click This user and click Browse. Click the List Names From field and select your local 
server. Select the ReqWeb_WordUser entry. Click Add and OK.

3 Enter and confirm the ReqWeb_Word User password that you defined when you 
created this user.

4 Click OK again to return to the Distributed COM Configuration Properties dialog 
box.

Note:  You must return to this dialog box before continuing with the next 
procedure.

Assigning Word Access Permissions for Administrators

1 On the Applications tab of the Distributed COM Configuration Properties dialog 
box, select Microsoft Word Document on the list of applications and click 
Properties. 

2 On the Security tab of the Microsoft Word Document Properties dialog box, click 
Use custom access permissions. Click the adjacent Edit button. 

3 At the Registry Value Permissions dialog box, click Add. 

4 At the Add Users and Groups dialog box, click the List Names From field and select 
your local server. 

5 Select the Administrators entry and click Add. 

6 At the Type of Access field, select Allow Access. Click OK.

7 Click OK several times to close the DCOM dialog boxes. 

8 Repeat the assigning access, launch, and identity procedures, described above, for 
the Microsoft Word Basic entry, if it appears in your DCOM application list.

9 Reboot your system.

Creating a Document Directory on the Requirements Server

In order to display RequisitePro documents, RequisiteWeb creates temporary 
directories that contain copies of the project documents on the RequisiteWeb 
Requirements server.  

To support these documents, create the following directory:

C:\Inetpub\wwwroot\ReqWebDoc\GenDoc
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IIS 5.0 on Windows 2000 Advanced Server automatically creates a virtual directory 
that is associated with the GenDoc physical directory. In IIS 4.0 on Windows NT 4.0, 
use the following procedure to manually create a ReqWebDoc virtual directory.

Note:  RequisiteWeb creates a word.tmp file in GenDoc while converting a Word 
document to HTML for viewing in the browser. While this file is present, no other 
users can convert documents. This file is deleted when the conversion is complete. In 
the case of a system crash, you may need to delete this file manually.

Creating a ReqWebDoc Virtual Directory on Windows NT 4.0

To create a virtual directory for RequisiteWeb on your RequisiteWeb Requirements 
server:

1 Click Start > Programs > Windows NT 4.0 Option Pack > Microsoft Internet Information Server 
> Internet Service Manager.

2 Right-click the Default Web Site and select New Virtual Directory.

3 In the Virtual Directory Creation Wizard, click Next and type an Alias: ReqWebDoc.

4 Click Next and browse to and select C:\Inetpub\wwwroot\ReqWebDoc\GenDoc.

5 Click Next, accept the default settings, and click Finish to complete the wizard.

6 Close the Internet Service Manager.

Installing the Oracle Client

In order to access RequisitePro projects that are stored in an Oracle database, you 
must configure Oracle client software on the Requirements server. Refer to the section 
Setting Up PCs for Oracle Access on page 23. That section refers to RequisitePro 
installation on a client PC; you must perform that procedure on the RequisiteWeb 
Requirements server. 

Important: When implementing a single-server RequisiteWeb configuration, you 
must install the Oracle client software before installing the JDK if you are using a 
version of Oracle that is earlier than 8.1.7. 
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Setting Up the Single-Server Configuration 

This section presents procedures for installing and configuring Web Server 
components on a single IIS Server. Perform the procedures described in Configuring 
the RequisiteWeb Requirements Server on page 44 before doing the following 
procedures. Be sure to log on as an administrator before you begin the installation 
process. These instructions assume that you have installed the Microsoft Internet 
Information Server (IIS) on your system and that it is running. For more information 
on IIS, see Microsoft Servers at www.microsoft.com/servers.

This section contains the following procedures:

1 Installing Java Components

2 Installing the Tomcat Servlet Engine

3 Configuring the ISAPI Redirector

4 Configuring Jakarta Virtual Directory on IIS

5 Adding a JSP Filter

6 Configuring the Environment Variables

7 Starting Tomcat

8 Testing Tomcat

9 Creating a ReqWeb Virtual Directory on IIS

10 Configuring the ReqWeb Directory

11 Editing the RequisiteWeb Configuration File

12 Final Steps

Installing Java Components 

Continue your configuration of the RequisiteWeb server by installing the Sun 
Microsystems Java Development Kit (JDK 1.2.2), which includes the Java Runtime 
Environment (JRE). 

If you already have the JDK installed on your system, check the version by entering 
the following at the MS-DOS shell command line: java -version
If your version is older than 1.2.2, you must upgrade to 1.2.2.

To install the JDK:
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1 Download the JDK executable file from the Sun Microsystems site at 
http://java.sun.com/products/jdk/1.2/download-windows.html. The 
self-extracting file you download is jdk-1_2_2_006-win.exe.

Note:  This Web site lists this product as the Java 2 Software Development Kit 
(SDK), Standard Edition, Version 1.2.2_006 for Microsoft Windows.

2 Execute the self-extracting JDK file at the root level on the Web server’s local hard 
drive. By default, the JDK creates files at the following locations:

❑ C:\jdk1.2.2

❑ C:\Program Files\JavaSoft\JRE\1.2

3 You can verify your Java installation by entering the following at the MS-DOS shell 
command line: java -version

Installing the Tomcat Servlet Engine 

To install Tomcat on your RequisiteWeb server:

1 Locate the jakarta-tomcat.zip file on the Rational Solutions for Windows CD, at the 
following location: \RequisitePro\ReqWeb\tomcat

2 Use WinZip to extract the jakarta-tomcat.zip file into the root (C:\) directory of 
your RequisiteWeb server. In the Extract dialog box, select the Use folder names 
check box. By unzipping this file into the C:\ root directory, WinZip creates the 
directory C:\jakarta-tomcat and its subdirectories.

Note:  Be sure you extract the contents of this file into the C:\ directory -- not a 
subdirectory.

3 Copy the ReqWeb.war Web archive file from the RequisiteWeb installation 
directory. By default, this is: C:\Program Files\Rational\RequisitePro\ReqWeb.
Paste the ReqWeb.war file into the directory: C:\jakarta-tomcat\webapps

Copying the server.xml and uriworkermap.properties files

Tomcat uses two configuration files: server.xml and uriworkermap.properties. These 
files must be modified in order to run RequisiteWeb.

Your RequisiteWeb installation includes preconfigured copies of the server.xml and 
uriworkermap.properties files at the following default location: 
C:\Program Files\Rational\RequisitePro\ReqWeb\tomcat
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1 Copy and paste those files to the following location: C:\jakarta-tomcat\conf\

2 Overwrite the existing versions of those files unless you are already running 
Tomcat on your system. In this case, see Previous Tomcat Installations, below.

Note:  Tomcat includes a Web server running on port 8080, which is not required for 
RequisiteWeb. You can disable this Web server by editing the Tomcat server.xml file. 
For more information, refer to the Tomcat documentation that is included in the 
Tomcat installation.

Previous Tomcat Installations

If you already have a previous installation of Tomcat, do not overwrite your current 
server.xml and uriworkermap.properties files; however, in this case you must add the 
following entries to those files:

Note:  Review the contents of the RequisiteWeb server.xml and 
uriworkermap.properties files for additional information.

Configuring the ISAPI Redirector 

1 Locate and copy the isapi_redirect.dll file at the following default location: 
C:\Program Files\Rational\RequisitePro\ReqWeb\tomcat

2 Create a directory named “jakarta” under the C:\Inetpub\wwwroot\

3 Paste the isapi_redirect.dll file into the new directory:
C:\Inetpub\wwwroot\jakarta

File New Entries

server.xml Add the following lines between the two XML tags <ContextManager 
...> and </ContextManager>:

<Context path="/ReqWeb" docbase="webapps/ReqWeb" 
debug=”0” reloadable="false" > </Context> 

Note: Be sure to enter this value without using carriage returns within the 
XML element. This entry is case-sensitive; enter it exactly as shown.

uriworkermap
.properties

Add the following lines to the end of the file:

# Mount ReqWeb
/ReqWeb/*.jsp=ajp12
56 Chapter 4 - Installing and Configuring Rational RequisiteWeb



4 Locate the tomcat-iis-W2K.reg file in the following default directory:
C:\Program Files\Rational\RequisitePro\ReqWeb\tomcat

Note:  This file assumes that you have configured the default Tomcat directory, 
C:\jakarta-tomcat. If you specified a different drive or installation directory, you 
must edit the tomcat-iis-W2K.reg file. 

5 Double-click the tomcat-iis-W2K.reg file. This creates the following Registry keys 
under the HKEY_LOCAL_MACHINE/SOFTWARE/:

❑ /Apache Software Foundation

❑ /Apache Software Foundation/Jakarta ISAPI Redirector

❑ /Apache Software Foundation/Jakarta ISAPI Redirector/1.0

Executing the tomcat-iis-W2K.reg file also adds the following String Values at the 
1.0 Registry key:

Note:  If Tomcat is not installed in the default location shown in the table above, you 
must modify the registry keys shown above to reflect the correct path. If you are 
installing RequisiteWeb on an international operating system, make sure that the 
Tomcat registry entries match your Tomcat installation paths.

Configuring Jakarta Virtual Directory on IIS 

To configure a virtual directory for Jakarta Tomcat on your RequisiteWeb server:

1 Launch the Internet Services Manager by doing one of the following:

❑ In Windows NT 4.0, click Start > Programs > Windows NT 4.0 Option Pack > Microsoft 
Internet Information Server > Internet Service Manager.

❑ In Windows 2000 Server, click Start > Programs > Administrative Tools/Internet 
Services Manager.

2 Expand the entry for the IIS <server name> on the tree.

String Value Value

extension_uri /jakarta/isapi_redirect.dll

log_file C:\jakarta-tomcat\logs\isapi.log

log_level error

worker_file C:\jakarta-tomcat\conf\workers.properties

worker_mount_file C:\jakarta-tomcat\conf\uriworkermap.properties
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3 Expand the Default Web Site folder.

4 Right-click the jakarta virtual folder and select Properties.

5 Do one of the following:

❑ In Windows 2000, in the Properties dialog box at the Virtual Directory tab, click 
the Execute permissions drop-down list and select Scripts and Executables.

❑ In Windows NT, in the Properties dialog box at the Directory tab, click the 
Execute (including script) Permissions option.

6 Click OK to close the dialog box. Leave the Internet Services Manager open.

Adding a JSP Filter 

The following filter setting instructs IIS to process JSP pages using Tomcat.

1 Right-click on the Default Web Site and select Properties.

2 At the ISAPI Filters tab, click Add.

3 Type the filter name: jakarta

4 Browse to and select: C:\Inetpub\wwwroot\jakarta\isapi_redirect.dll

5 Click OK to close the dialog boxes.

6 Close the Internet Services Manager.

Configuring the Environment Variables

1 On the Start menu, click Settings > Control Panel. In the Control Panel, double-click 
the System icon. The System Properties dialog box appears.

2 Do one of the following:

❑ In Windows 2000, at the Advanced tab, click Environment Variables.

❑ In Windows NT, click the Environment tab.

3 Add or modify the following system environment variables with the 
corresponding values, as shown. The PATH entry must be added to the existing 
PATH values on your system.

Note:  The path for the following applications may vary on your system. Be sure to 
use the correct value when specifying the path for these environment variables.
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Starting Tomcat 

1 In the MS-DOS shell, type the following: cd C:\jakarta-tomcat\bin

2 Type the following: tomcat start

3 Leave the MS-DOS shells open. Closing the shells terminates the Tomcat process.

When Tomcat starts, the ReqWeb.war file expands to create a full directory structure 
for the RequisiteWeb components.

Note:  You must restart Tomcat whenever the Web Server is rebooted. The user who 
starts Tomcat must remained logged on to the server as long as Tomcat and 
RequisiteWeb are in use. This user must have write permissions to the directories 
containing the RequisitePro .rqs project files, whether they are on the local machine or 
a remote server. If you have security questions related to this condition, contact 
Rational Software Technical Support.

Testing Tomcat 

To verify that Tomcat is installed and configured correctly:

1 Open a browser on your IIS server and enter the following URL address: 
//<servername>:8080/examples/

A list of JSP examples should appear. If it does not, check the steps for installing 
Tomcat, above; or, refer to the documentation in the /jakarta-tomcat/doc directory. 

2 Click the link to jsp. On the page that appears, click the Execute link to right of 
NumberGuess. A guessing game should appear.

Table 12 Setting Environment Variables

Variable Value 

JAVA_HOME C:\jdk1.2.2

TOMCAT_HOME C:\jakarta-tomcat

TOMCAT_OPTS -DJINTEGRA_NATIVE_MODE  
-DJINTEGRA_COINIT_VALUE=0

PATH <existing PATH>;%JAVA_HOME%\bin
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Creating a ReqWeb Virtual Directory on IIS
Note:  If you have a previous instance of a ReqWeb virtual directory on this server, do 
not add another one. In Internet Service Manager, right-click on the ReqWeb virtual 
directory and select Properties. At the Virtual Directory tab, enter the following at the 
Local Path field: C:\jakarta-tomcat\webapps\ReqWeb. Then go to step 7 in the 
following procedure. 

To create a virtual directory for RequisiteWeb on your IIS server:

1 Launch the Internet Services Manager by doing one of the following:

❑ In Windows NT 4.0, click Start > Programs > Windows NT 4.0 Option Pack > Microsoft 
Internet Information Server > Internet Service Manager.

❑ In Windows 2000 Server, click: Start > Programs > Administrative Tools/Internet 
Services Manager.

2 Expand the Default Web Site and verify that you do not have a ReqWeb virtual 
directory. If you do, refer to the note above.

3 Right-click the Default Web Site and select New Virtual Directory.

4 In the Virtual Directory Creation Wizard, click Next and type an Alias: ReqWeb.

5 Click Next and browse to and select C:\jakarta-tomcat\webapps\ReqWeb

6 Click Next and Finish to complete the wizard.

7 Right-click the Default Web Site and select Properties.

8 Do one of the following:

❑ On Windows 2000, click the Web Site tab.

❑ On Windows NT, click the Performance tab.

9 Clear the HTTP Keep-Alives Enabled check box. Click OK to close the dialog box.
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Configuring the ReqWeb Directory

Use the Internet Services Manager to configure the ReqWeb virtual directory. Make 
the entries as shown in the following table. Be sure to follow the instructions in the 
column that corresponds to your operating system.

Table 13 ReqWeb Virtual Directory Configuration in IIS

Step Windows NT 4.0/IIS 4.0 Windows 2000 Server/IIS 5.0

1 Right-click the ReqWeb virtual directory 
(located under the Default Web Site) and 
select Properties. 

Right-click the ReqWeb virtual directory 
(located under the Default Web Site) and 
select Properties. 

2 At the Properties dialog box, click the 
Virtual Directory tab.

Select Read permission; clear Write 
permission.

Be sure that the Application Settings section 
contains the Name “ReqWeb”.

Clear the box Run in separate memory space.

At the Permissions list, select Script.

Click Configuration.

At the Properties dialog box, click the 
Virtual Directory tab.

Select Read permission; clear Write 
permission.

Clear the Directory Browsing check box.

Be sure that the Application Settings section 
contains the Application Name “ReqWeb”.

Accept Medium Application Protection.

Click Configuration.

3 At the Application Configuration dialog 
box, click the App Options tab.

Select Enable session state.

Set ASP Script timeout to at least 90 seconds. 
Click OK.

At the Application Configuration dialog 
box, click the App Options tab.

Select Enable session state.

Set ASP Script timeout to at least 90 seconds. 
Click OK.

4 At the Properties dialog box, click the 
Directory Security tab.

In Anonymous Access and Authentication 
Control, click Edit.

At the Properties dialog box, click the 
Directory Security tab.

In Anonymous access and authentication 
control, click Edit.

5 At the Authentication Methods dialog box, 
select Allow Anonymous Access and click 
Edit.

At the Authentication Methods dialog box, 
select Anonymous Access and click Edit.
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Editing the RequisiteWeb Configuration File

To configure RequisiteWeb, execute the RWConfig Java utility as follows:

1 Open an MS-DOS shell and navigate to the following directory:  
C:\jakarta-tomcat\webapps\ReqWeb\WEB-INF\classes

2 Type the following at the MS-DOS prompt:
set classpath=%classpath%;.

3 Type the following command to execute the RWConfig Java utility: 

java RWConfig 

4 For each setting (shown in the table below), accept the default or modify the value, 
as necessary.

Note:  You must enter the RequisiteWeb server name in the RPXHTTP value. Other 
entries are provided by default; check to see whether they are correct for your 
installation.

6 In the Anonymous User Account dialog 
box, at Username field, replace the default 
entry by typing: ReqWeb_RPXUser 

Clear the check box Enable Automatic 
Password Synchronization. Click OK twice.

In the Anonymous User Account dialog 
box, at Username field, replace the default 
entry by typing: ReqWeb_RPXUser 

Clear the check box Allow IIS to control 
password. Click OK twice.

7 At the Properties dialog box, click the 
Documents tab. 

Select the Enable Default Document check 
box.  Click Add.

At the Add Default Document dialog box, 
type index.html. Click OK.

At the Properties dialog box, on the 
Documents tab, select the index.html 
entry in the default document list. Use the 
up arrow to move that entry to the top of 
the list.

Click OK.

At the Properties dialog box, click the 
Documents tab. 

Select the Enable Default Document check 
box. Click Add.

At the Add Default Document dialog box, 
type index.html. Click OK.

At the Properties dialog box, on the 
Documents tab, select the index.html 
entry in the default document list. Use the 
up arrow to move that entry to the top of 
the list.

Click OK.

8 Close the Internet Service Manager Close the Internet Services Manager.

Table 13 ReqWeb Virtual Directory Configuration in IIS
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Setting Switch Value

User ID /uid Press Enter to accept the default setting of <Blank>. If 
another value is shown, type DEL to set the entry to blank.

Password /Password Press Enter to accept the default setting of <Blank>. If 
another value is shown, type DEL to set the entry to blank.

Server Name /RPXhost Press Enter to accept the default setting of <Blank>. If 
another value is shown, type DEL to set the entry to blank.

Domain /RPXdomain Press Enter to accept the default setting of <Blank>. If 
another value is shown, type DEL to set the entry to blank.

RPXHTTP /RPXHTTP HTTP://<server name>/ReqWebDoc/GenDoc/

Note: This case-sensitive entry is the URL to the directory 
for Microsoft Word temporary files. You must replace the 
<server name> entry with the correct RequisiteWeb 
server name.

RPXDocPath /RPXDocPath C:\Inetpub\wwwroot\ReqWebDoc\GenDoc\

Note: This is the default location of temporary files 
generated by Microsoft Word. Modify this value if you 
have a different configuration.

RPXCatalog /RPXCatalog C:\Program Files\Rational\RequisitePro\
ReqWeb\Projects\catalog.txt

Note: This is the default location of the RequisitePro 
projects catalog file on the server.  Modify this value if you 
have a different configuration.

Language /Language Press Enter to accept the default setting of “en” for English. 
Do not change this value unless your version of 
RequisiteWeb has been translated into your local language. 
This value is based on ISO639 language code standards.  If 
you are using a Japanese version of RequisiteWeb, use the 
value “ja”.

Country /Country Press Enter to accept the default setting of “US” for United 
States. Do not change this value unless your version of 
RequisiteWeb has been translated into your local language. 
This value is based on ISO3166 country code standards. If 
you are using a Japanese version of RequisiteWeb, use the 
value “jp”.
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Note:  To set an individual parameter, run the RWConfig Java utility with one of the 
switches shown in the table above. For example, to change the path of the catalog file, 
enter the following at the command line in the classes directory:  
java RWConfig /RPXCatalog

Note:  The values you enter are stored in the following file: 
C:\jakarta-tomcat\webapps\ReqWeb\WEB-INF\classes\config.txt

Maintaining RequisiteWeb Service

You must restart Tomcat whenever the Web Server is rebooted. The user who starts 
Tomcat must remain logged on to the server as long as Tomcat and RequisiteWeb are 
in use. This user must have write permissions to the directories containing the 
RequisitePro .rqs project files, whether they are on the local machine or a remote 
server. If you are done configuring RequisiteWeb, press Ctrl-Alt-Delete and lock your 
computer. If you have security questions related to this condition, contact Rational 
Software Technical Support.

Final Steps

To finish configuring your RequisiteWeb installation, refer to the following sections:

� Managing RequisitePro Projects for RequisiteWeb on page 76

� Configuring E-mail for Discussions on page 77

� Starting RequisiteWeb on page 78 
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Setting Up the Dual-Server Configuration

Configuring the Web Server

This section contains procedures for configuring your HTTP Web server for hosting 
RequisiteWeb on Sun Microsystems Solaris and Linux. Be sure to log on as an 
administrator before beginning your installation process. This installation assumes 
that you have installed the Apache Web server on your system. For more information 
on installing the Apache Web server, see Apache HTTP Server Project at 
www.apache.org.

Note:  Samples in this section use the BASH shell (GNU Bourne-Again Shell) in the 
UNIX operating system. For example, the instructions for setting environment 
variables use the export command. Modify the samples with appropriate syntax for 
your OS shell.

Note:  The paths and file names for your installation of the JDK, Apache Web server, 
and Tomcat may vary from the examples shown. Be sure to the provide the correct 
paths and file names.

This section contains the following procedures:

1 Installing Java Components 

2 Testing the Apache Web Server Shared Object Handling 

3 Configuring the Apache Web Server 

4 Installing Tomcat 

5 Installing Jserv 

6 Configuring Apache for Tomcat  

7 Installing RequisiteWeb Components on the Web Server 

8 Editing the RequisiteWeb Configuration File 
Setting Up the Dual-Server Configuration 65



Installing Java Components

Begin your configuration of the RequisiteWeb HTTP server by installing the Java 
Development Kit (JDK 1.2.2), which includes the Java Runtime Environment (JRE). 

1 If you already have the JDK installed on your system, check the version by 
entering the following at the system command line: java -version
If your version is older than 1.2.2, you must upgrade to 1.2.2.

2 Download and install the appropriate JDK (1.2.2 or higher) for your system's 
hardware and operating system. The JDK is available from Sun Microsystems at 
http://java.sun.com.

Note:  Your distribution of the JDK may create a jdk1.2 directory. The following 
instructions refer to a jdk1.2.2 directory.

3 Set the environment variable JAVA_HOME to the name of your JDK directory:

export JAVA_HOME=/usr/local/jdk1.2.2

4 Add the JDK bin directory to your PATH environment variable:

export PATH=$PATH:$JAVA_HOME/bin

5 Add all of the JAR files in your JDK's lib directory to your CLASSPATH 
environment variable. For example:

export CLASSPATH=.:$JAVA_HOME/lib/tools.jar

Note:  Make the environment changes permanent by adding the export commands, 
above, to your login script, such as the /etc/profile file.

Testing the Apache Web Server Shared Object Handling

Verify that Apache can load shared objects, which are necessary for RequisiteWeb.

1 Navigate to the directory that contains Apache's binary files; typically, this is 
/usr/local/apache/bin. 

Note:  Your Apache installation may be in /usr/apache.

2 Type the following command: /usr/local/apache/bin/httpd -l

If this command prints a line containing “mod_so.c” or “mod_so” then your 
installation will work for RequisiteWeb. Otherwise, use a different distribution or 
compile the Apache source files on your system. 
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Configuring the Apache Web Server

Perform the following configuration tasks for your Apache Web server installation.

In order to configure the Apache Web server for RequisiteWeb, you must copy the 
configuration files in /usr/local/apache/conf to new file names. This creates copies of 
the originally distributed example configuration files. 

1 Navigate to the Apache configuration directory by typing the following:
cd /usr/local/apache/conf

2 Rename the sample configuration files using the copy command:
cp access.conf-dist access.conf
cp httpd.conf-dist httpd.conf
cp srm.conf-dist srm.conf

Note:  Your Apache distribution may use .conf-example or another extension 
rather than the .conf-dist extension for these files.

3 Edit the .conf text files as needed:
The ServerRoot entry and subsequent lines, shown below, contain the path to your 
Apache Web server installation directory. Be sure that this path is correct.

ServerRoot      /usr/local/apache
DocumentRoot    /usr/local/apache/htdocs
Alias /icons/   "/usr/local/apache/icons/"
<Directory "/usr/local/apache/icons">

Options Indexes MultiViews
AllowOverride None
Order allow,deny
Allow from all

</Directory>
ScriptAlias /cgi-bin/ "/usr/local/apache/cgi-bin/"
<Directory "/usr/local/apache/cgi-bin">

AllowOverride None
Options None
Order allow,deny
Allow from all

</Directory>

Important: You will need to supply the path (shown in the value of the ServerRoot 
entry) when installing Jserv in a subsequent procedure.

4 Find the line defining the variable ServerName and set it to the host name your 
Web site visitors will use. This might be a host name, such as reqweb.rational.com, 
or an IP address, such as 192.168.1.1.

ServerName reqweb.rational.com
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5 Optionally, make additional performance, security, and application changes to 
httpd.conf. By default, the httpd.conf file assigns the Apache Web server the same 
permissions that are assigned to the “nobody” user and group, as indicated by the 
following entries:

User nobody

Group nobody

See the file: /usr/local/apache/htdocs/manual/misc/security_tips.html 
for more security information. If you encounter problems, there is abundant 
documentation on installing and configuring Apache at the Web site: 
http://www.apache.org.

Starting and Verifying the Apache Web Server

1 To start Apache, type the command:

/usr/local/apache/bin/apachectl start

2 Open your Web browser and enter an address for your server name 
(http://<servername>/) or local host (http://localhost/). Apache's “Test Page for 
Apache Installation” should appear. If you receive an error message, check the logs 
in /usr/local/apache, double-check httpd.conf, and check the process list to see if 
Apache is really running. Enter one of the following:

❑ ps -Af | grep httpd     (on Solaris)

❑ ps -auwwx | grep httpd  (on Linux)

If this command prints a list of processes, Apache is running. Otherwise, Apache 
did not start.

Installing Tomcat

1 Locate the jakarta-tomcat.tar.gz file on the Rational Solutions for Windows CD, at 
the following location: cd /cdrom/RequisitePro/ReqWeb/tomcat

2 Copy this file into a directory where you want to install Tomcat. This 
documentation uses /usr/local as the parent directory for the Tomcat installation. 
Therefore, your file should be saved as /usr/local/jakarta-tomcat.tar.gz.  
cp jakarta-tomcat.tar.gz /usr/local

3 Change to the /usr/local directory: 
cd /usr/local

4 Extract the Tomcat binaries:

gunzip -c jakarta-tomcat.tar.gz | tar -xvf -
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5 Set the TOMCAT_HOME environment variable to the directory where you 
installed Tomcat:

export TOMCAT_HOME=/usr/local/jakarta-tomcat

Note:  Make the environment changes permanent by adding the export command, 
above, to your login script, such as the /etc/profile file.

Starting and Testing Tomcat

1 To start Tomcat, type the following:

/usr/local/jakarta-tomcat/bin/startup.sh

2 To test Tomcat, enter the following address in your browser: 
http://<servername>:8080/examples
You should be able see example Web applications, including pages that run Java 
Servlets and JSPs. If not, check the following:

❑ Your current PATH must contain the path to the “java” executable; for example 
$JAVA_HOME/bin

❑ Your JAVA_HOME environment variable must be assigned to the JDK 
installation directory; for example /usr/local/jdk1.2.2

❑ Your TOMCAT_HOME environment variable must be assigned to the Tomcat 
installation directory; for example /usr/local/jakarta-tomcat

❑ Tomcat should have exclusive access to its ports. If there are one or more other 
programs “listening” to Tomcat's ports, you should see a Java BindException 
message when starting Tomcat. By default, Tomcat uses the TCP/IP ports 8007 
and 8080 on your machine. If there is a conflict, you can change which ports 
Tomcat uses by editing the file: /usr/local/jakarta-tomcat/conf/server.xml.

❑ Tomcat must be running. To verify this, type one of the following:

ps -Af | grep tomcat    (on Solaris)

ps -auwwx | grep tomcat (on Linux)

Note:  You must restart Tomcat whenever the Web server or the Requirements server 
is rebooted. 
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Installing Jserv 

Jserv is an executable shared object that Tomcat uses to communicate with the Apache 
Web server. For Linux systems, use the compiled shared object, described in 
”Installing Jserv on Linux,” below. For Solaris systems, you must compile Jserv on 
your system; refer to the section “Compiling Jserv on Solaris,” below.

Installing Jserv on Linux

1 Locate the mod_jserv.so file on the Rational Solutions for Windows CD, at the 
following location:  cd /cdrom/RequisitePro/ReqWeb/tomcat

2 Copy the mod_jserv.so file into Apache's libexec directory in the ServerRoot 
directory, which is specified in the httpd.conf file, by typing the following:

cp mod_jserv.so /usr/local/apache/libexec

Refer to Configuring the Apache Web Server on page 67 to identify the ServerRoot 
directory.

3 Assign root ownership and executable permission:

cd /usr/local/apache/libexec

chown root:root mod_jserv.so

chmod +x mod_jserv.so

Compiling Jserv on Solaris

Prior to installing Jserv on the Solaris operating system, you must compile it. In order 
to compile Jserv, you must have the following utilities:

� ANSI-C compliant compiler

� Perl script interpreter

� Apache extension tool Perl script (apxs)

ANSI-C Compliant Compiler

Check whether you have an ANSI-C compiler such as GNU's gcc installed. Solaris 
machines often do not have an ANSI-C compiler; if not, install the GNUgcc package 
for your version of Solaris. Make sure this compiler is included in your path:

export PATH=$PATH:<GNUgcc path>/bin

To create a link to the compiler (on Solaris systems only):

1 Find the cc program in your file structure:

which cc
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2 Navigate to that directory.

cd /usr/ucb

3 Rename the cc program to a backup copy, such as cc.old.

mv cc cc.old

4 Create a link to gcc.

ln -s /usr/local/bin/gcc cc

Perl Script Interpreter

Most Solaris machines have a pre-installed Perl interpreter. Use the following 
command to locate your executable Perl interpreter:

which perl

This outputs the full path and name of the interpreter program, for example:

/usr/bin/perl

Apache Extension Tool Perl Script (apxs)

The apxs script is a Perl script that allows you to compile programs that extend 
Apache. By default, it is located in /usr/local/apache/bin. Verify that you can run this 
script; for example, type: /usr/local/apache/bin/apxs

Note:  If you cannot run apxs, check that the line at the top of the apxs file matches the 
location of your perl interpreter; for example #!/usr/bin/perl

1 Navigate to the directory containing the Jserv source code:

cd /usr/local/jakarta-tomcat/src/native/apache/jserv

2 Compile mod_jserv.c:

/usr/local/apache/bin/apxs -c -o mod_jserv.so *.c

Be sure to enter this command exactly as shown, including spaces. This produces 
an executable called mod_jserv.so.

3 Copy the mod_jserv.so executable into Apache's libexec directory in the 
ServerRoot directory, which is specified in the httpd.conf file. Refer to Configuring 
the Apache Web Server on page 67 to identify the ServerRoot directory.

cp mod_jserv.so /usr/local/apache/libexec
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Configuring Apache for Tomcat

Tomcat generates a configuration file that enables Apache to communicate with 
Tomcat. You must edit this configuration file to ensure this communication:

1 To stop Apache and Tomcat, type the following:

/usr/local/apache/bin/apachectl stop

/usr/local/jakarta-tomcat/bin/shutdown.sh

2 Open the following file in an editor:

/usr/local/apache/conf/httpd.conf

3 Add the following line to the end of the file:

Include /usr/local/jakarta-tomcat/conf/tomcat-apache.conf

4 Start Tomcat:

/usr/local/jakarta-tomcat/bin/startup.sh

Tomcat generates the tomcat-apache.conf configuration file.

5 Start Apache:

/usr/local/apache/bin/apachectl start

      Apache reads the configuration file.

6 If Apache does not start, check for the following conditions:

❑ There is a typographic error in the file: 
/usr/local/apache/conf/httpd.conf

❑ Apache cannot find the file: 
/usr/local/jakarta-tomcat/conf/tomcat-apache.conf

❑ Apache cannot find the file: 
/usr/local/apache/libexec/mod_jserv.so

❑ Apache cannot read and execute the file: 
/usr/local/apache/libexec/mod_jserv.so

❑ There are duplicate or conflicting configuration entries in the following files: 
/usr/local/apache/conf/httpd.conf 
/usr/local/jakarta-tomcat/tomcat-apache.conf

7 If Apache still does not start, examine the Apache log files in the following 
directory: /usr/local/apache/logs
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Installing RequisiteWeb Components on the Web Server
1 Navigate to the directory that contains the ReqWeb.war file on the Rational 

Solutions for Windows CD: 
cd /cdrom/RequisitePro/ReqWeb/

2 Copy the ReqWeb.war file into Tomcat's Web applications directory:

cp ReqWeb.war /usr/local/jakarta-tomcat/webapps

3 Locate the preconfigured server.xml file from the following default location: 
cd /cdrom/RequisitePro/ReqWeb/tomcat/

4 Copy it into the following location: /usr/local/jakarta-tomcat/conf/
cp server.xml /usr/local/jakarta-tomcat/conf/

Note:  If you already have a previous installation of Tomcat, do not overwrite your 
current server.xml file; however, you must make the following addition to that file:

Add the following lines between the two XML tags <ContextManager ...> 
and </ContextManager>:

<Context path="/ReqWeb" docbase="webapps/ReqWeb" debug=”0” 

reloadable="false" > </Context> 

Note:  Be sure to enter this value without using carriage returns within the XML 
element. This entry is case-sensitive; enter it exactly as shown.

5 Optional step: Tomcat includes a Web server running on port 8080, which is not 
required for RequisiteWeb. You can disable this Web server by editing the Tomcat 
server.xml file. For more information, refer to the Tomcat documentation that is 
included in the Tomcat installation.

6 Stop Tomcat:

/usr/local/jakarta-tomcat/shutdown.sh

7 Stop Apache:

/usr/local/apache/bin/apachectl stop

8 Create the following folder: 

mkdir /usr/local/jakarta-tomcat/webapps/reqweb

Note:  This new reqweb directory is in addition to the existing ReqWeb directory.

9 Copy the index.html file from the ReqWeb directory to the reqweb directory:

cp /usr/local/jakarta-tomcat/webapps/ReqWeb/index.html 

/usr/local/jakarta-tomcat/webapps/reqweb
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10 Start Tomcat:

/usr/local/jakarta-tomcat/startup.sh

Note:  This may take a few moments longer than usual because Tomcat must 
extract and decompress ReqWeb.war.

11 Start Apache:

/usr/local/apache/bin/apachectl start

Editing the RequisiteWeb Configuration File 

To configure RequisiteWeb, execute the RWConfig Java utility as follows:

1 Open a shell and navigate to the following directory:  
/usr/local/jakarta-tomcat/webapps/ReqWeb/WEB-INF/classes

2 Type the following at the shell prompt:
export CLASSPATH=$CLASSPATH:.

3 Type the following command to execute the RWConfig Java utility: 

java RWConfig 

4 For each setting, accept the default or modify the value, as necessary.

Note:  You must enter the RequisiteWeb server name in the RPXHTTP value. Other 
entries are provided by default and may be correct for your installation. 

Setting Switch Value

User ID /uid Enter the user ID: ReqWeb_RPXUser

Note: This is the user that RequisiteWeb uses to log on to 
the Requirements server.

Password /Password Enter the password for the ReqWeb_RPXUser.

Server Name /RPXhost Enter the Requirements server name. Depending on your 
network configuration, you may need to enter the server 
IP address instead of the server name. Contact your 
system administrator for more information.

Domain /RPXdomain Enter the domain name for the Requirements server. If the 
domain name is not valid, DCOM searches for the user ID 
on the local server. If there is no domain, enter a 
placeholder value, such as RequisiteWeb.
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Note:  To set an individual parameter, run the RWConfig Java utility with one of the 
switches shown in the table above. For example, to change the path of the catalog file, 
enter the following at the command line in the classes directory: 
java RWConfig /RPXCatalog

Note:  The values you enter are stored in the following file: 
/usr/local/jakarta-tomcat/webapps/ReqWeb/WEB-INF/classes/config.txt

RPXHTTP /RPXHTTP HTTP://<server name>/ReqWebDoc/GenDoc/

Note: This case-sensitive entry is the URL to the directory 
on the Requirements server for Microsoft Word 
temporary files. You must replace the <server name> 
entry with the correct server name.

RPXDocPath /RPXDocPath C:\Inetpub\wwwroot\ReqWebDoc\GenDoc\

Note: This is the default location of temporary files 
generated by Microsoft Word on the Requirements server. 
Modify this value if you have a different configuration.

RPXCatalog /RPXCatalog C:\Program Files\Rational\RequisitePro\
ReqWeb\Projects\catalog.txt

Note: This is the default location of the RequisitePro 
projects catalog file on the Requirements server.  Modify 
this value if you have a different configuration.

Language /Language Press Enter to accept the default setting of “en” for 
English. Do not change this value unless your version of 
RequisiteWeb has been translated into your local 
language. This value is based on ISO639 language code 
standards.  If you are using a Japanese version of 
RequisiteWeb, use the value “ja”.

Country /Country Press Enter to accept the default setting of “US” for 
United States. Do not change this value unless your 
version of RequisiteWeb has been translated into your 
local language. This value is based on ISO3166 country 
code standards. If you are using a Japanese version of 
RequisiteWeb, use the value “jp”.

Setting Switch Value
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Managing RequisitePro Projects for RequisiteWeb

While RequisiteWeb provides features for accessing and editing requirements and 
documents in projects, you must use the full RequisitePro PC client application to 
create projects and documents. RequisitePro offers project templates and other 
management tools for creating and modifying project structure and security. For more 
information refer to the guide Using Rational RequisitePro or the RequisitePro online 
help.

Using the RequisiteWeb Project Catalog 

RequisiteWeb uses a catalog text file to provide access to RequisitePro projects. By 
default, the file contains entries for the RequisitePro Learning Project and another 
sample project. The projects that are listed in your catalog file appear in the Projects 
drop-down list on the RequisiteWeb logon page.

To add your own projects to the catalog, you must enter the full path for the project 
file, which has a .rqs extension. For instructions on modifying the catalog, see Editing 
the RequisitePro Projects Catalog on page 77.

Accessing Projects on Different Servers 

If you are using Microsoft Access for your RequisitePro project database, the database 
file must be located on the RequisiteWeb Requirements server. By default, local 
projects are created in the following directory: 
\Program Files\Rational\RequisitePro\ReqWeb\Projects. 

RequisiteWeb can open SQL Server- and Oracle-based projects that are not physically 
located on the RequisiteWeb Requirements server; however, in this case the 
ReqWeb_RPXUser domain user must have Change or Modify permission for the 
directory containing the RequisitePro .rqs project file on the remote project server.

In order to access RequisitePro projects that are stored in an Oracle database, you 
must configure Oracle client software on the Requirements server. Refer to the section 
Setting Up PCs for Oracle Access on page 23. That section refers to a RequisitePro 
installation on a client PC; you must perform that procedure on the Requirements 
server. 

Important: When implementing a single-server RequisiteWeb configuration, you 
must install the Oracle client software before installing the JDK if you are using a 
version of Oracle that is earlier than 8.1.7.

After installing or upgrading RequisiteWeb, the projects that are not located on your 
RequisiteWeb Requirements server may not be visible in the Projects drop-down list, 
even though they are listed in your catalog file. To refresh the project list, run the 
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DCOM configuration application by typing dcomcnfg at the Start > Run command 
line. The DCOM application appears; close it. Check your projects list in 
RequisiteWeb. 

Editing the RequisitePro Projects Catalog 

To edit the catalog, perform the following procedure on the RequisiteWeb server in 
the single-server configuration or on the Requirements server in the dual-server 
configuration:

1 Navigate to the directory: 
C:\Program Files\Rational\RequisitePro\ReqWeb\Projects

2 Using a text editor, open the catalog.txt file. 

3 Create an entry on each line with the full path to the RequisitePro project file. Copy 
the format of default project entries. 

Note:  Use a full path for local projects on the Requirements server. To access 
projects on another server, you must specify a Universal Naming Convention 
(UNC) path to the shared folder containing the RequisitePro .rqs file. 

4 Save and close the catalog.txt file.

Note:  In order to view updates to the catalog.txt file, users must log off RequisiteWeb 
and then select a project at the initial RequisiteWeb entry page.

Configuring E-mail for Discussions

To configure e-mail for RequisitePro discussions, refer to Configuring E-mail for 
Discussions on page 13 in this guide. You use the same Rational E-mail Reader session 
for both RequisitePro and RequisiteWeb; however, note the following requirements 
when configuring the Rational E-mail Reader for both RequisitePro and 
RequisiteWeb: 

� You must run the Rational E-mail Reader on a different server than the IIS server.

� In order to enable e-mail for RequisiteWeb discussions, you must configure 
discussion e-mail using the SMTP protocol option in the Rational E-mail Reader. 
The MAPI protocol option is not supported for RequisitePro or RequisiteWeb.

� The E-mail Setup option on the RequisitePro Tools menu does not configure e-mail 
for RequisiteWeb discussions. Use the Rational E-mail Reader, as described  on 
page 13, to configure e-mail for RequisiteWeb discussions.
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Starting RequisiteWeb

To access a RequisitePro project in RequisiteWeb:

1 Open your browser.

2 Set the URL address to the full path to the logon page in the RequisiteWeb virtual 
directory; for example: http://<server name>/reqweb

Note:  Be sure to use the server name rather than an IP address.

3 Navigate to that address. The RequisiteWeb logon page appears.

4 Select a RequisitePro project from the Project list. If your project does not appear on 
the list, refer to the procedure Managing RequisitePro Projects for RequisiteWeb on 
page 76. 

5 Type your RequisitePro User name and Password and click Log on.

Removing RequisiteWeb

This section describes how to remove RequisiteWeb from an IIS server. Prior to 
removing RequisiteWeb from your system, make sure that no one is using 
RequisiteWeb or any associated files. You will not be able to remove files that are in 
use.

RequisiteWeb installs a new project catalog containing paths to new sample projects. 
Be sure to make a copy of your existing catalog.txt file before removing RequisiteWeb. 
Add your previous catalog.txt entries to the new catalog file that is installed with the 
new version of RequisiteWeb. For more information, see Managing RequisitePro 
Projects for RequisiteWeb on page 76.

Removing RequisiteWeb on Windows with IIS

To remove RequisiteWeb from a Windows NT or Windows 2000 server, you must 
have Windows administrator privileges on that machine. Use the following 
instructions to:

� Remove or redirect the ReqWeb virtual directory

� Stop the IIS Admin Service

� Remove the RequisiteWeb program files

� Restart your Web Publishing Service
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Removing or Redirecting the ReqWeb Virtual Directory

1 Launch the Internet Services Manager by doing one of the following:

❑ Click Start > Run, and type inetmgr. Click OK.

❑ In Windows NT 4.0, click Start > Programs > Windows NT 4.0 Option Pack > Microsoft 
Internet Information Server > Internet Service Manager.

❑ In Windows 2000 Server, click Start > Programs > Administrative Tools/Internet 
Services Manager.

2 Select the Default Web Site and click the Stop button on the toolbar.

3 Right-click on the ReqWeb virtual directory and select Properties. The ReqWeb 
Properties dialog box appears. Click the Virtual Directory tab.

4 Depending on whether you are upgrading or simply removing RequisiteWeb from 
your system, do one of the following:

❑ If you are upgrading to a new version of RequisiteWeb, do not delete your 
ReqWeb virtual directory. After you have installed your new version of 
RequisiteWeb, you will redirect the ReqWeb virtual directory to the new path, 
as described in Creating a ReqWeb Virtual Directory on IIS on page 60. 

❑ If you are not upgrading, but simply removing all RequisiteWeb components 
from your system, click Remove and click OK to close the dialog box.

Stopping the IIS Admin Service

Perform the instructions in the following table. Refer to the column that corresponds 
to your operating system.

Step Windows NT 4.0 Windows 2000 Advanced Server

1 Close the Internet Service Manager. In the Internet Services Manager, 
right-click on the server name.

2 At the Start/Run command line, type 
cmd. 

Select Restart IIS.

3 In the MS-DOS window, type the 
following:
net stop iisadmin /y 
and press Enter. 

At the Stop/Start/Reboot dialog box, 
select Stop Internet Services on <server 
name>.
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Removing the RequisiteWeb Program

Use the Add/Remove Programs function in the Windows Control Panel to select and 
remove RequisitePro. After the uninstall process is complete, check to see if the 
C:\Program Files\Rational\RequisitePro\ReqWeb directory is still present on the 
server. If so, delete the ReqWeb directory and its subdirectories.  

Restarting the Web Publishing Service

Perform the instructions in the following table. Refer to the column that corresponds 
to your operating system.

Removing RequisiteWeb from a Unix Web Server

To remove RequisiteWeb components  from your Solaris or Linux Web Server, you  
need to remove directories and environment variables.

Warning:  Be sure that you only delete those components that are not required for 
other applications on your server.

Note:   When removing environment variables, check the /etc/profile file to ensure that 
the environment variables are cleared for all sessions.

4 The following message appears: “The 
IIS Admin Service was stopped 
successfully.” The C:\ prompt 
appears after the command is 
successfully executed. Type exit to close 
the MS-DOS window.

Click OK to close the dialog box.

Close the Internet Services Manager.

Step Windows NT 4.0 Windows 2000 Advanced Server

1 In the MS-DOS window, type the 
following: 
net start w3svc 
and press Enter.

In the Internet Services Manager, 
right-click on your server name.

2 The following message appears: “The 
World Wide Web Publishing Service was 
started successfully.” The C:\ prompt 
appears after the command is 
successfully executed.

Select Restart IIS. 

At the Stop/Start/Reboot dialog box, 
select Restart Internet Services on <server 
name>.

3  Type exit to close the MS-DOS window. Click OK to close the dialog box and close 
the Internet Services Manager.

Step Windows NT 4.0 Windows 2000 Advanced Server
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Removing the Java Development Kit

Remove the following directory and its subdirectories from the server: 

/usr/local/jdk1.2.2

Remove the JAVA_HOME and CLASSPATH environment variables.

Removing Tomcat

Remove the following directories and their subdirectories from the server: 

� /usr/local/apache

� /usr/local/jakarta-tomcat

Remove the following environment variable from the server:

� TOMCAT_HOME
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5Troubleshooting
If you have any problems running the Rational Software Setup program, try the 
following suggestions before you call Rational Customer Support for help:

� Be sure to stop all applications before you begin the installation.

� Turn off all virus protection software. These programs often run in the background 
and interfere with the installation and file decompression process.

� Turn off any user interface managers or desktop environments that run on top of 
Microsoft Windows.

� Change to a standard VGA video driver while Rational Setup is running, or 
disable video features such as virtual screens or screen switching.

� Change to a standard mouse driver, or disable special mouse features that perform 
tasks such as leaving pointer trails or changing pointer sizes.

� Make certain that your system meets the minimum system requirements listed in: 
“System and Software Requirements” on page 2 and 
“RequisiteWeb System Requirements” on page 38.

Installation Messages

Contact Rational Customer Support for information and assistance regarding any 
error messages you encounter while installing Rational software. See “Contacting 
Rational Technical Support” on page xiv contact information.
83



Installation error messages, including messages for silent installations, are displayed 
in the file <Install Path>\RSSetup\Error.log. For more information on silent 
installations, refer to the guide Installing Rational Suite, which is included on the CD: 
Rational Solutions for Windows – Online Documentation CD.

Support Information

Contact Rational Customer Support if you have questions regarding the installation, 
use, or maintenance of this Rational Software product.

Contacting Rational Technical Support on page xiv provides Rational Customer Support 
telephone and e-mail contact information.

Table 14 Silent Installation Messages

Message Description

Product “ProductName” specified in 
response file is not contained in the 
product list.

This error message appears when the 
response.ini file contains an 
invalid product name.

Unable to open response file. Typically, this error occurs when the 
installation procedure cannot locate 
the response.ini file. Either you 
have specified an incorrect path or 
the response.ini file is not in the 
default location. 

Information required to remove the 
specified product cannot be found. 
The product may not be removed 
automatically.

When trying to remove a product 
with the /uninstall switch, you 
either specified a product that is not 
installed on your system or you 
incorrectly typed the product name 
on the command line.

Confirm that you are specifying a 
product on your system. Confirm 
that you have typed the product 
name exactly as it appears in the 
Rational Software Setup program.
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